Klocwork Installation and Upgrade
Version 9.6
## Contents

### Articles

**Before you install**

1. About the Klocwork packages and components  
   1
2. System requirements  
   2

**Upgrading from a previous version**

12.

1. Upgrading from a previous version  
   12
2. Installing the Klocwork Server package on Windows -- Upgrade only  
   20
3. Installing the Klocwork Server package on Unix -- Upgrade only  
   21
4. Installing the Klocwork Server package on Mac -- Upgrade only  
   24

**Installing the Server package**

26.

1. Installing Klocwork Insight  
   26
2. Installing the Klocwork Server package on Windows  
   27
3. Unattended installation on Windows  
   29
4. Installing the Klocwork Server package on Unix  
   31
5. Installing the Klocwork Server package on Mac  
   34
6. kwupdate  
   36

**Installing the User package**

38.

1. Installing the Klocwork User package on Windows  
   38
2. Installing the Klocwork User package on Unix  
   39
3. Installing the Klocwork User package on Mac  
   42
4. Installing the Klocwork plug-in from the Eclipse update site  
   43
5. Running a custom installation for new or upgraded IDEs  
   44

**Installing the Distributed Analysis package**

46.

1. Installing the Distributed Analysis package  
   46

**Configuring and starting the Klocwork servers**

49.

1. Viewing and changing Klocwork server settings  
   49
2. Starting the Klocwork Servers  
   51
3. Stopping the Klocwork Servers  
   53
4. kwservice  
   55

**Testing your installation**

59.
Testing your installation

What to communicate to the team

Troubleshooting

Repairing a Windows installation of Klocwork Insight
Package Load Failure occurs in Visual Studio after I install patch
Error reading setup initialization file during installation
Klocwork support for non-ASCII encoding
Unable to start Klocwork Servers following Windows installation
IntelliJ IDEA installation not detected; plugin not installed

Uninstalling

Uninstalling Klocwork Insight
Unable to start Klocwork Servers following Windows installation

References

Article Sources and Contributors
Image Sources, Licenses and Contributors

Article Licenses

License
Before you install

About the Klocwork packages and components

The Klocwork Insight installation packages and components allow you to install only the components you need on a specific machine.

The main installation packages are:
- Server (kw-server-installer)
- User (kw-user-installer)

Note: The Distributed Analysis package is covered separately in Installing the Distributed Analysis package.

Server package components

<table>
<thead>
<tr>
<th>Component</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Server</td>
<td>MySQL database server (command-line name: database). Contains data for Klocwork Review and Klocwork Architect. You can also use your own separate installation of MySQL. Default host: localhost Default port: 3306</td>
</tr>
<tr>
<td>License Server</td>
<td>A FLEXlm license manager (command-line name: license). You can also use your organization's FLEXlm server. Default host: localhost Default port: 27000 plus 33133</td>
</tr>
</tbody>
</table>
| Klocwork build tools | Integration build analysis tools:  
  - tools for managing Klocwork projects, analysis and access control (kwadmin and kwbuildproject)  
  - tools to produce a build specification (kwinject, kwwrap, kwant, kwesproparser)  
  - tools for running Klocwork integration build analysis (the analysis engines)  
  - tools for managing Klocwork projects and access control  
  - sample projects |
| Klocwork projects_root directory | The data location for the Klocwork Servers and applications, including the project database tables, which are stored in MySQL and Lucene databases. For information about default location and special considerations for this data directory, see Projects_root directory. Note: The projects_root directory is not one of the components you see listed in the installation wizard, but the wizard lets you choose a location for it. |
User package components

<table>
<thead>
<tr>
<th>Component</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Klocwork Architect (part of GUI/Web tools)</td>
<td>Extracts an accurate graphical view of the design of your organization’s software directly from existing source code (C/C++ and Java)</td>
</tr>
</tbody>
</table>
| Klocwork command line            | Command-line versions of the Klocwork developer tools for C/C++ and Java, which allow software developers to verify the quality of source code before they commit it to source control. Also includes Klocwork Desktop, a GUI alternative to running kwcheck.  
  Note: This component also includes the Klocwork Extensibility API for writing custom checkers. |
| IDE integration (plug-ins)       | Klocwork developer tool plug-ins for C/C++, C# and Java, for supported IDEs.                                                                                                                                 |
| Checker Studio                   | Allows you to browse the Abstract Syntax Tree (AST) structure of your code to help you identify nodes of interest in order to create custom C/C++ or Java KAST checkers.                                      |

Note: The specific IDE plug-ins are only visible during installation if the relevant IDEs are installed on your machine. For example, if you do not have Microsoft Visual Studio 2005 installed, you will not see "Klocwork for C/C++ in Visual Studio 2005".

System requirements

Supported platforms

Both the Klocwork Server and User packages are supported on the following operating systems (except where noted). This means that Klocwork has performed the full test suite on these operating systems with certain hardware and will provide technical support as specified in the Klocwork support policies.

Note: It is not possible to use Klocwork tools with SELinux (Security-Enhanced Linux) enabled.

<table>
<thead>
<tr>
<th>Processor</th>
<th>Operating system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun SPARC</td>
<td>Sun Solaris 8, 9 and 10</td>
</tr>
<tr>
<td>Intel and AMD</td>
<td>Red Hat Enterprise Linux 4.x, 5.x, 6.x</td>
</tr>
<tr>
<td>32 bit and 64 bit</td>
<td>SUSE Enterprise 10 (32-bit only), 11</td>
</tr>
<tr>
<td></td>
<td>In addition Klocwork supports all recent Linux distributions such as Fedora, Open Suse, Ubuntu, CentOS and Debian running glibc 2.3 or greater (use getconf GNU_LIBC_VERSION to find out your version). If you have any questions about your distribution, please contact Customer Support.</td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2003</td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional</td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
</tr>
<tr>
<td></td>
<td>Mac OS X Snow Leopard (10.6)</td>
</tr>
<tr>
<td></td>
<td>Mac OS X Lion (10.7)</td>
</tr>
<tr>
<td>IBM Power5 64 bit</td>
<td>IBM AIX 5.3, TL 7 (Server package only)</td>
</tr>
</tbody>
</table>
## Operating system patches and packages

The following patches or packages are required for running Klocwork products (either server or user installations) on certain operating systems. They are in addition to the regular maintenance patches for your operating system.

<table>
<thead>
<tr>
<th>If you are installing on...</th>
<th>you need...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris 8</td>
<td>Sun OS patch 108434-03</td>
</tr>
<tr>
<td>Solaris 8 or 9</td>
<td>GTK</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The minimum version required to run Klocwork Desktop, part of the Klocwork Desktop Command Line in the User Package, is GTK 2.2.1. To install GTK, perform the following steps: Switch to super user: <code>su -</code> Make sure the pkg-get tool is installed. Update your local copy of the catalog (optional): <code># pkg-get -U</code> Download and install GTK and all its dependencies automatically: <code># pkg-get -i gtk</code> Switch back to the normal user: <code># exit</code> <strong>Note:</strong> pkg-get installs all software to <code>/opt/csw</code>. Export the <code>LD_LIBRARY_PATH</code> environment variable to <code>/opt/csw/lib</code> before running GTK.</td>
</tr>
</tbody>
</table>
| Solaris 8, 9, or 10          | The patches required for Java 1.6. Klocwork installs and uses Java 1.6. The requirements for Java are listed in the Sun release notes: [1]
|                             | This page also provides a link for downloading recommended and required patches. The zlib package (not required if you are installing only Klocwork Architect or Klocwork developer tools). a) Check that the zlib package is installed. To check that the zlib package is installed, either run `$ pkginfo | grep zlib` or look for a file called `libz.so` under `/usr/lib` or `/usr/local/lib`. If the zlib package is installed, you will see the package SUNWzlib, or SMCzlib, or both packages. b) If the zlib package is not installed, install it. There are two methods. **Method 1.** Install it from the Solaris 8 Software CD 2 of 2. Mount the CD to the system (it should mount automatically. If it doesn’t, mount it manually). `$ su -` `# pkgadd -d /cdrom/cdrom0/Solaris_8/Product SUNWzlib` This command installs zlib to `/usr/lib`. **Method 2.** Install it from a downloaded package. Download the zlib package from [http://sunfreeware.com](http://sunfreeware.com). `# gzip -d zlib-1.x.x-sol8-sparc-local.gz` `# pkgadd -d ./zlib-1.x.x-sol8-sparc-local` This command installs zlib to `/usr/local/lib`. |
System requirements

| Linux x86, 64-bit | The 32-bit compatibility libraries must be installed. Klocwork Insight works on 64-bit platforms in 32-bit emulation mode, so in order for Klocwork Insight to work on Linux 64-bit platforms, you must ensure that the 32-bit libraries are installed. The way you check and install 32-bit libraries depends on your Linux distribution. For example, for Ubuntu, run the following command to install 32-bit compatibility libraries:
$ sudo apt-get install ia32-libs
The 32-bit version of the libncursesw library must be installed.
• For Fedora Core and Redhat Enterprise Linux, run these commands:
  $ sudo yum install ncurses-libs.i686
  $ sudo yum install glibc.i686
  $ sudo yum install libgcc.i686
• For Ubuntu (except v8.04), run this command:
  $ sudo apt-get install lib32ncursesw5
• For Ubuntu 8.04:
  Download a .deb file from [2]
  Run this command:
  $ sudo dpkg --install lib32ncursesw5_5.7+20090207-1ubuntu1_amd64.deb

| Any Linux distribution that does not install the X11 version of X Window by default | xorg-XFree86-deprecated-libs

| Red Hat Enterprise Linux (RHEL) 4 | libpng10-1.0.13-8.i386.rpm

| Ubuntu 6.06 | libxpm-dev

Operating systems that support Flexera FLEXnet ID Dongles

A FLEXnet ID Dongle is a hardware key, also referred to as a dongle, used to lock software access to the machine on which it is physically installed.

You can use FLEXnet ID Dongles in situations where you:
• cannot release any system information such as MAC addresses or IP addresses
• cannot share a license server between multiple sites

There is more information on FLEXnet ID Dongles on the Flexera Web site.

To use Flexera FLEXnet ID Dongles, use one of the following operating systems with the appropriate FLEXnet driver, with HOSTID_FLEXid9 using FLEXnet 11.10.1.0. You can obtain the appropriate driver for your operating system from Klocwork Customer Support.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>FLEXnet driver installer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Hat Enterprise Linux 4.x, 5.x, 6.x</td>
<td>aksusb-redhat-1.8.1-3.i386.rpm</td>
</tr>
<tr>
<td>Windows 2000 Professional</td>
<td>FLEXIdInstaller.exe, FLEXId.exe or FLEXIdsilent.exe</td>
</tr>
<tr>
<td>Windows Server 2003</td>
<td></td>
</tr>
<tr>
<td>Windows XP Professional</td>
<td></td>
</tr>
<tr>
<td>Windows Vista (32 bit and 64 bit)</td>
<td>FLEXId_Dongle_Driver_Installer.exe (choose the FLEXid9 driver)</td>
</tr>
</tbody>
</table>

Notes:
• You must install Flexera FLEXnet ID Dongles at the root/Administrator privilege. For Unix, use su/sudo. For Windows, use an Administrator group.
• After installing Flexera FLEXnet ID Dongles on Windows, restart the Klocwork Servers.
The Linux Red Hat Package Manager (RPM) installer emits an error message about checkpc. Ignore the error message.

Disk space requirements

Disk space requirements for installation
A complete installation requires 400 to 450 Mbytes for installation. Additional disk space is required temporarily during installation.

Disk space requirements for data storage
Klocwork Insight data includes the source files, configuration files, object files, tables, and the database. The total disk space needed for a single integration-build analysis will be the total of all this data. If you use Klocwork incremental analysis, the object file size and table size is needed only once per project.

Some sample projects to show how size can vary

<table>
<thead>
<tr>
<th>Project</th>
<th>Language</th>
<th>Lines of code</th>
<th>Object file size (Mbytes)</th>
<th>Table size (Mbytes)</th>
<th>Database size (Mbytes)</th>
<th>Total size (Mbytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boost</td>
<td>C/C++</td>
<td>6,300</td>
<td>393</td>
<td>17</td>
<td>84</td>
<td>494</td>
</tr>
<tr>
<td>Firefox</td>
<td>C/C++</td>
<td>1,200,000</td>
<td>2,800</td>
<td>606</td>
<td>702</td>
<td>4,108</td>
</tr>
<tr>
<td>X.org</td>
<td>C</td>
<td>1,500,000</td>
<td>2,600</td>
<td>608</td>
<td>720</td>
<td>3,928</td>
</tr>
<tr>
<td>Linux</td>
<td>C</td>
<td>2,300,000</td>
<td>7,200</td>
<td>1,100</td>
<td>1,200</td>
<td>9,500</td>
</tr>
<tr>
<td>Common C++</td>
<td>C/C++</td>
<td>20,000</td>
<td>168</td>
<td>23</td>
<td>45</td>
<td>236</td>
</tr>
<tr>
<td>Python</td>
<td>C</td>
<td>192,000</td>
<td>114</td>
<td>52</td>
<td>84</td>
<td>250</td>
</tr>
<tr>
<td>MySQL</td>
<td>C/C++</td>
<td>350,000</td>
<td>781</td>
<td>133</td>
<td>167</td>
<td>1,081</td>
</tr>
</tbody>
</table>

Processor and RAM requirements

Server and complete installations
- Processor speed: 2 GHz or better
- RAM: 2 Gbytes. More than 2 Gbytes may be required for very large analyses. Note that the size of a build and its RAM requirements depend not only on the lines of code, but also on the number and complexity of relationships in the code. If you are using parallel or multicore processing, you should allocate a minimum of 1 GB of memory per processor or core. You can also improve Klocwork performance with multiple core processors.

User installations
### System requirements

<table>
<thead>
<tr>
<th>Klocwork client</th>
<th>Processor speed</th>
<th>RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Klocwork for C/C++</td>
<td>1 GHz or better</td>
<td>1 Gbyte. On Windows and with precompiled headers, the minimum RAM is 2 GB.</td>
</tr>
<tr>
<td>Klocwork for Java</td>
<td>1 GHz or better</td>
<td>1 Gbyte.</td>
</tr>
<tr>
<td>Architect</td>
<td>1 GHz or better</td>
<td>1-2 Gbytes recommended</td>
</tr>
<tr>
<td>Klocwork Review and Klocwork Inspect</td>
<td>1 GHz or better</td>
<td>1-2 Gbytes recommended</td>
</tr>
</tbody>
</table>

### Java Virtual Machine requirements

#### Windows

If you don't have Java 1.6 Update 31 installed, the Server, User or Distributed Analysis installation package will install Java 1.6 Update 31. It will be installed in `<server_install>/_jvm/bin/` and `<user_install>/_jvm/bin/`. Your system must meet the requirements for this version of Java.

If you have a later update of Java 1.6, Java will not be installed, and Insight will use the already installed version.

The installation package detects whether you have a 32-bit or 64-bit operating system and installs the appropriate version of Java.

#### Linux and Solaris

Insight installs Java 1.6 Update 31. Your system must meet the requirements for this version of Java.

On Linux, there is a separate installation package for both 32-bit and 64-bit Java. Select the one that matches your operating system.

Only 32-bit Java is supported for Solaris.

#### Mac

You must install JVM 1.6 Update 31 or later on your machine before installing the Klocwork Server or User package. If you have a previous JVM version installed and you try to install the Server or User package, you will see the error message, "Version of Java is too old". Apple supplies their own version of Java. Use the Software Update feature on your Mac.

Only 32-bit Java is supported for Mac.

#### AIX

Insight installs and uses IBM Java 1.6, so your system must meet the requirements for Java 1.6. At the time of publication, the link to supported system configurations for IBM Java 1.6 was:


Only 32-bit Java is supported for AIX.

#### IDE plug-ins

The Klocwork Desktop Java Plug-ins for Eclipse and IntelliJ IDEA require Java 1.6. You must ensure that your IDE is running on Oracle (Sun) Java 1.6.
Supported IDEs

Note: Klocwork Insight also has successful integrations with other Eclipse-based IDEs.

Supported C/C++ IDEs

<table>
<thead>
<tr>
<th>IDE</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eclipse</td>
<td>3.4, 3.5, 3.6, 3.7 and 4.2</td>
</tr>
<tr>
<td>Wind River Workbench</td>
<td>3.1, 3.2</td>
</tr>
<tr>
<td>QNX Momentics</td>
<td>4.6, 4.7</td>
</tr>
</tbody>
</table>

*The Express edition of Visual Studio is not supported.*

Supported C# IDEs


The Smart Device project type is not supported.

Supported Java IDEs

<table>
<thead>
<tr>
<th>IDE</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eclipse</td>
<td>3.4, 3.5, 3.6, 3.7, 4.2</td>
</tr>
<tr>
<td>JetBrains IntelliJ IDEA</td>
<td>8.x, 9.0, 10.0, 10.5, 11.x</td>
</tr>
<tr>
<td>IBM Rational Application Developer for WebSphere</td>
<td>7.5.x at the level of &quot;Ready for IBM Rational Software&quot; for Eclipse-based solutions</td>
</tr>
</tbody>
</table>

Supported browsers

A browser is required for Klocwork Architect reports, for Klocwork Review, and for Klocwork Inspect.

- Mozilla Firefox - the current, latest release except for the AIX platform, which is at 3.5.13.1
- Internet Explorer 8* and 9
- Apple Safari 5.x
- Google Chrome - the current latest release

*Not supported for Klocwork Inspect

Note: Klocwork Review and Klocwork Inspect also require that you enable cookies in your browser.
**Supported PDF readers**

Required for viewing reports in Klocwork Architect.

- Adobe Acrobat Reader 5.0 or higher

**Python**

- On Unix, the Insight installation will install Python 2.7 if it is not detected on your machine.

**Supported source code management systems for Klocwork Inspect**

Inspect has been tested with the following, for both pre-checkin and post-checkin code reviews:

- Base ClearCase 7.x
- CVS 1.12.x
- Git 1.7.x
- TFS 2010
- Perforce Visual Client 2010.x
- Subversion 1.4.x, 1.6.x, 1.7.x

Note that Eclipse code review supports only the Subversive plug-in.

For other SCMs, please contact Klocwork Customer Support [4].

**C/C++ compilers supported for build integration**

As part of creating a build specification, Klocwork Insight automatically searches for the following compiler types by default. If your compiler is not on this list, contact Klocwork Customer Support [4] so that we can support your compiler. For details on compilers and on creating build specifications generally, see Creating a C/C++ build specification.

<table>
<thead>
<tr>
<th>Compiler type</th>
<th>Klocwork compiler code</th>
<th>Names of common compiler variants</th>
<th>Introduced</th>
<th>Improved</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Devices Blackfin and TigerSHARC</td>
<td>dsp</td>
<td>ccblkfa, ccts</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>ARM</td>
<td>armcc</td>
<td>armcc, armcpp, tcc, tccpp</td>
<td>Pre-9.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ar</td>
<td>armlink</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>armar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CADUL C cross compiler for Intel 80X86</td>
<td>cadul_compile</td>
<td>ccu38o</td>
<td>9.6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>cadul_link</td>
<td>lnka38a</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CodeWarrior Freescale S12</td>
<td>chc12</td>
<td>chc12</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>Compiler caching tools</td>
<td>ccache</td>
<td>ccache, distcc</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>Cosmic</td>
<td>cosmiccompile</td>
<td>cxs12x, cx6812, cx6816, cxstm8</td>
<td>9.5</td>
<td>9.6</td>
</tr>
<tr>
<td></td>
<td>cosmiclink</td>
<td>clnk</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Embarcadero compiler/linker</td>
<td>bcc</td>
<td>bcc32</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>blink</td>
<td>ilink32</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fujitsu FR Family</td>
<td>fcc</td>
<td>fcc911s, fcc907s</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>GNU</td>
<td>gnu</td>
<td>gcc, g++, cc, c++</td>
<td>Pre-9.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>gnu_ld</td>
<td>ld</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GNU ar</td>
<td>ar</td>
<td>ar</td>
<td>Pre-9.5</td>
<td></td>
</tr>
</tbody>
</table>
### System requirements

<table>
<thead>
<tr>
<th>Developer</th>
<th>Tools</th>
<th>Pre-9.5</th>
<th>9.6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green Hills GHS</td>
<td>ghs, ghscom, ghslink, ghsar</td>
<td>gcc, gex, cearm, exarm, ccms, cxms, ccinttpc, exinttpc, ecomarm, ecomppc, elxr, ax</td>
<td></td>
</tr>
<tr>
<td>Hexagon Tools</td>
<td>qdsp</td>
<td>qdsp-gcc, qdsp-g++</td>
<td>9.5</td>
</tr>
<tr>
<td>HI-TECH C compiler/linker</td>
<td>picc, piclink</td>
<td>picc, hlink</td>
<td></td>
</tr>
<tr>
<td>Hitachi ch38</td>
<td>ch38</td>
<td>ch38.exe</td>
<td>Pre-9.5</td>
</tr>
<tr>
<td>IAR Systems C compiler/linker for 8051/NEC V850/MSP430/M16C/Renesas RX210/CR16C/ARM/Atmel AVR (see Limitations)</td>
<td></td>
<td></td>
<td>Pre-9.5</td>
</tr>
<tr>
<td>ImageCraft AVR</td>
<td>iccavr</td>
<td>iccavr</td>
<td>9.5</td>
</tr>
<tr>
<td>Intel C++</td>
<td>ic, ic1</td>
<td>ic, icpc, icl</td>
<td></td>
</tr>
<tr>
<td>Intel iC-386</td>
<td>c386</td>
<td>c386a</td>
<td>9.6</td>
</tr>
<tr>
<td>Intel XL C/C++</td>
<td>xlc</td>
<td>cc, xlc, xIC and related commands (see <code>&lt;klocwork_install&gt;/config/kwfilter.conf</code> for full list)</td>
<td>9.5</td>
</tr>
<tr>
<td>Keil CA51</td>
<td>c51, lx51</td>
<td>c51, cx51, c166, c251, lx51, l166, l251</td>
<td>9.5</td>
</tr>
<tr>
<td>MetaWare High C/C++</td>
<td>arc, ararc, ldarc, mcc</td>
<td>hearc, hcaec, ararc, arac, ldarc, ldac, mcc</td>
<td></td>
</tr>
<tr>
<td>Metrowerks CodeWarrior</td>
<td>mwc</td>
<td>mwc, mwccmcf</td>
<td>Pre-9.5</td>
</tr>
<tr>
<td>Microchip MPLAB pic24</td>
<td>pic30</td>
<td>pic30-gcc</td>
<td>9.5</td>
</tr>
<tr>
<td>Microsoft Visual C++</td>
<td>mscompile, mslink</td>
<td>cl, clamr, link, lib</td>
<td>Pre-9.5</td>
</tr>
<tr>
<td>Microtec</td>
<td>mcx, mlk</td>
<td>mcx, mlk</td>
<td>9.5</td>
</tr>
<tr>
<td>Motorola DSP563</td>
<td>moto563compile, moto563link</td>
<td>g563c, dsplnk</td>
<td>9.6</td>
</tr>
<tr>
<td>MPLAB C18</td>
<td>mcc18, mplink</td>
<td>mcc18, mplink</td>
<td>9.5</td>
</tr>
<tr>
<td>Nvidia CUDA</td>
<td>nvcc</td>
<td>nvcc</td>
<td>9.6</td>
</tr>
<tr>
<td>Panasonic C</td>
<td>cc103S, ld103S</td>
<td>cc103S, ld103S</td>
<td>9.5</td>
</tr>
<tr>
<td>Paradigm C/C++</td>
<td>pcc, plink</td>
<td>pcc, plink</td>
<td>9.6</td>
</tr>
<tr>
<td>Compiler</td>
<td>Command Line</td>
<td>Recommended Version</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------</td>
<td>---------------------</td>
<td></td>
</tr>
<tr>
<td>Plan 9 C</td>
<td>plan9 ar</td>
<td>0c, 1c, 2c, 5c, 6c, 7c, 8c, 9c, kc, qc, vc ar.l</td>
<td>9.5</td>
</tr>
<tr>
<td>QNX</td>
<td>qnx qcc</td>
<td>Pre-9.5</td>
<td></td>
</tr>
<tr>
<td>Renesas 78K0R</td>
<td>ren_cc78 cc78k0r</td>
<td>9.6</td>
<td></td>
</tr>
<tr>
<td>Renesas SuperH and RX family</td>
<td>rxc compile rxc, shc optlk</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>Renesas R8C and M16C families</td>
<td>nc30 nc30</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>Renesas V850</td>
<td>ca850 ld850 ca850 ld850</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>Star Core Freescale</td>
<td>scc sc100-ld scc sc100-ld</td>
<td>Pre-9.5</td>
<td></td>
</tr>
<tr>
<td>Sun Studio C/C++</td>
<td>sun CC, cc</td>
<td>Pre-9.5</td>
<td></td>
</tr>
<tr>
<td>Tasking Classic Toolset for C166 compiler/linker</td>
<td>tasking_classic_166_compile tasking_classic_166_link</td>
<td>cc166 l166</td>
<td>9.5 9.6</td>
</tr>
<tr>
<td>Tasking IFX SLE88</td>
<td>cj2</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>Tasking Tricore</td>
<td>tricore_compile tricore_link cctc ltc</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>Tasking VX Toolset for C166 compiler/linker</td>
<td>tasking_166_compile tasking_166_link</td>
<td>cc166 lkt166</td>
<td>9.6</td>
</tr>
<tr>
<td>Tensilica Xtensa C/C++</td>
<td>xtensa xt-xc xt-xc++</td>
<td>9.6</td>
<td></td>
</tr>
<tr>
<td>TI ARP32 C/C++</td>
<td>cl_arp32</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>TI msp430 C/C++</td>
<td>cl430</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>TI tms320c6x and tms320c55x</td>
<td>cl6x link6x ar6x cl6x, cl55 link6x ar6x</td>
<td>Pre-9.5</td>
<td></td>
</tr>
<tr>
<td>TI tms470</td>
<td>cl470 link2000 cl470 link470 ar470</td>
<td>9.6</td>
<td></td>
</tr>
<tr>
<td>TriMedia tmcc</td>
<td>tmcc tmcc tmCC</td>
<td>Pre-9.5</td>
<td></td>
</tr>
<tr>
<td>WinAVR</td>
<td>gnu ar</td>
<td>avr-gcc, avr-g++ avr-ar</td>
<td>9.6</td>
</tr>
<tr>
<td>Wind River Diab</td>
<td>diab dld ar</td>
<td>dcc, dplus dld dar</td>
<td>Pre-9.5</td>
</tr>
<tr>
<td>Wind River GCC</td>
<td>gnu gpppe</td>
<td>9.5</td>
<td></td>
</tr>
<tr>
<td>ZiLOG eZ80</td>
<td>ez80ce ez80link ez80ce ez80link</td>
<td>9.5</td>
<td></td>
</tr>
</tbody>
</table>
Supported C# language specifications

Klocwork Insight support versions 1.0, 2.0 and 3.0 of the C# language specification.

Application servers supported by Klocwork JSP scanning

Klocwork’s JSP scanning supports the following application servers:

<table>
<thead>
<tr>
<th>Application server</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apache Tomcat</td>
<td>5.5, 6.0</td>
</tr>
<tr>
<td>BEA WebLogic</td>
<td>10</td>
</tr>
</tbody>
</table>

Supported versions of MySQL

The Database Server is a MySQL 5.1.63 database server. If you want to use your own manually installed MySQL database server, it must be version 5.1.63. If necessary, upgrade your separate MySQL database before you install or upgrade Klocwork Insight.

Supported LDAP servers

- Windows Server 2003: Microsoft Active Directory
- Linux: OpenLDAP
- Sun Java System Directory
- Novell eDirectory

References

[4] mailto:support@klocwork.com
Upgrading from a previous version

Before you begin

IMPORTANT NOTICES
If you are upgrading from version 8.x, you will need a new license for version 9.6. Contact Customer Support [4].

If you are upgrading from version 9.1 or earlier: The database schema changed significantly in version 9.2. As a result, the migration script runs a MySQL database integrity check, which takes a significant amount of time. To reduce the amount of time required for migration, we strongly recommend that you delete unneeded projects and failed builds before migration, as detailed in the procedure that follows.

We also recommend that you make a copy of your projects_root directory and migrate the copy. This way, users can continue to use Klocwork Review, though they should be instructed not to make any changes, such as changing an issue’s status.

If you do not use the default server settings, you will need to specify your custom settings prior to beginning the upgrade. Otherwise, during the installation these settings will revert back to the default settings. If you forget, you can always go in and change the settings for each of your environments after you have completed upgrading.

To avoid losing issues, status changes or comments from the last release in your first release 9.6 analysis run, make sure you read Before your first 9.6 integration build analysis.

See also:
• Changes affecting migration
• Changes to licensing
• Limitations for installation, upgrade and deployment

Supported upgrade paths
Upgrade from the most recent service release of a major release is supported.

Due to database schema and license changes, we recommend a particular path when upgrading from previous versions of Klocwork Insight. Find your current version in the chart below and follow the appropriate path. If you are upgrading from a release earlier than 8.0, contact Customer Support [4] for further instructions.
If you're using Insight version | Apply this service release | Then follow this upgrade path
--- | --- | ---
8.0 | 8.0 SR3 | 8.0 SR3 -> 9.0 SR1 -> 9.6
8.1 | 8.1 SR1 Refresh | 8.1 SR1 Refresh -> 9.1 GA -> 9.6
8.2 | 8.2 SR1 | 8.2 SR1 -> 9.2 SR3 -> 9.6
9.0 | 9.0 SR1 | 9.0 SR1 -> 9.6
9.1 | None | 9.1 -> 9.6
9.2 | 9.2 SR3 | 9.2 SR3 -> 9.6
9.5 | 9.5 SR1 | 9.5 SR1 -> 9.6

Important changes since Insight 8.0

To see what's new or changed in this release, see What's New and the Release Notes. If you are upgrading from one of the older releases, also see What's New and the Release Notes from intervening versions so that you will understand what changed.

Here's a list of the changes since Insight 8.0 that are most likely to affect you during and after upgrade:

**Insight 8.1**

It is no longer possible to create a project from C/C++ source root directories. C/C++ projects must be based on one of the following:

- build specification
- Visual Studio project, solution or workspace
- existing tables

Creating a project from Java source root directories is still supported, but only for projects built in a non-Ant environment.

See Integration build analysis for information on running the integration build analysis.

**Insight 8.2**

- **Issue states** are no longer displayed by the desktop analysis tools. Instead, issues introduced locally are identified as "local", and issues identified in the integration build analysis are identified as "system". This makes it simpler to locate and fix your own issues. See Origin (local or system).

- **How issues are mapped between versions and builds**: Depending on how many changes in the source code have occurred, changes to line and column numbers, function signatures and function names are generally handled successfully between versions and builds. For example, if only the line number is changed, the issue will be propagated. If all of the above are changed, however, successful propagation will depend on how many similar issues are reported on that same function. If the name of the file containing the reported issue changes, the issue will not be migrated or propagated. In addition, changing the name of a variable can often affect migration and propagation, due to the fact that the analysis engine needs to differentiate issues related to different variables. In both these cases, the existing issue will be reported as "fixed", and a "new" issue will be reported.

- **Possible changes in numbers of reported issues due to changes in how issues are grouped**: Prior to Insight 8.2, it was possible to specify whether similar issues of the same type would be reported as one issue or multiple issues. The KMC option "Group similar errors", which controlled this functionality, has been removed in version 8.2. In version 8.2, similar C/C++ issues of the same type will be reported as one issue. Similar Java issues of the same type will be reported as multiple issues. This was the default behavior in previous versions of Klocwork. If you had changed the default behavior in version 8.1 or earlier, you may see differences in the numbers of reported issues once you run your first analysis with version 8.2 or later.
Insight 9.0

- To enhance security when Basic, LDAP or NIS access control is configured, all **users must now be authenticated** with the Klocwork Server. For GUI tools, a dialog will prompt users to log in; command-line tools will prompt users to run a new command, kwauth. Each user needs to log in only once; a token is then stored in the user's home directory. User passwords are not stored. See Setting up access control.
- When upgrading from versions earlier than 9.0, a **new license** is required to run Klocwork Insight.
- Continuous analysis: By default, the C/C++ plug-ins for Visual Studio and Eclipse as well as Klocwork Desktop now run **continuous analysis**, checking for issues whenever you access or save a file, providing automatic defect highlighting while you work in your editor.
- The Project Server and Web Server have been combined into one, called the **Klocwork Server**. Connected desktops are now linked with the Klocwork Server instead of the Project Server.

Insight 9.1

- Reporting is now separate from build configuration.
- Issue categories are converted to taxonomies during migration, which may affect numbers of detected issues after migration[^1].
- It is no longer possible to **load tables built with a previous version** of Insight. Instead, you will need to re-analyze the project by supplying a build specification to kwbuildproject.

Insight 9.2

- There is now only **one Eclipse update site** for both Java and C/C++. The installation option for both Unix and Windows installers is now Eclipse.
- **Administrator access** is required to install all Windows packages.
- Performance changes required modifications to the MySQL database. A database integrity check is performed during migration, so **migration will take significantly longer** than in previous releases.
- If **Java 1.6** is not detected on your Windows machine, it will be installed with the Klocwork installation packages.
- The compiler filter files (**<compiler_name>_filter.xml**) have been removed. These files no longer need to be migrated. All compiler configuration is now contained in Python scripts, which are not editable. For all compiler configuration issues, contact Customer Support[^4]. See Adding an unsupported C/C++ compiler for more information.

Insight 9.5

- There are now some differences in the way Insight data is migrated from a previous version:
  - The way that issue severities and states are categorized is somewhat different, and will become apparent after your first integration build analysis for a project. See Before your first 9.6 integration build analysis. If you need a mapping of issue severities between version 9.5 and a previous version, contact Customer Support[^4].
  - The concept of "scopes" in Insight has been replaced by views. See Help - I'm used to scoping in Klocwork Review.
  - Some custom reports are treated differently. See Reporting for the integration build and Customizing metrics reports in Klocwork Review.
  - The concept of "components" in Insight has been replaced by modules. The **modules.xml** file is no longer supported, and existing files are converted to modules during migration. Any modules that can't be converted are reported in **kwmigrate.log**. See Organizing your code into modules.
  - Three new roles exist in Insight 9.5: Build engineer, Developer and Manager, but the roles don't exist by default for migrated projects_roots. See Enabling access to Klocwork projects.
  - In Visual Studio, local defects aren't migrated from previous versions.
Upgrading from a previous version

- Support for 64-bit Java has been added for Windows and Linux. See the appropriate installation page.
- All administrative tasks have been moved from KMC to Klocwork Review, with many new web interface features to make administration of projects and builds, users and roles easier. See Managing integration projects and builds.
- Improvements to desktop analysis include:
  - Support for the Eclipse plug-in on a 64-bit JVM for Windows and Linux.
  - Support for the Klocwork Desktop Java Plug-in in IntelliJ IDEA 10 and 10.5. See Using Klocwork Desktop Java Plug-in for IntelliJ IDEA.
  - Klocwork Desktop support for Java projects in addition to C/C++. See Getting started with Klocwork Desktop for Java.
  - Added support for a number of C++11 language extensions. See Supported C/C++ language extensions [2].
- All users of Klocwork Visual Studio C/C++ and Eclipse C/C++ now have access to Klocwork Refactoring without a separate license. See Klocwork Refactoring.
- Klocwork Inspect supports more SCMs. See Supported SCMs.
- There is added support for new C/C++ compilers. See Supported C/C++ compilers.

Interoperability between releases

Clients earlier than Klocwork Insight 9.6 cannot interoperate with a Klocwork Insight 9.6 Server. You must upgrade both your Server and User installations to Klocwork Insight 9.6.

Running two versions of the Klocwork Servers

If you will be running two sets of the Klocwork Servers, for example to test the Klocwork Insight 9.6 Servers while users continue to access your existing servers, you must run them on different projects_root directories (and set the ports appropriately).

Handling licensing when using versions 8.x and 9.x

Versions 8.x and 9.x of Insight use two different license versions. However, it is possible to run both 8.x and 9.x simultaneously. There are three scenarios in which you would want to run both versions:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up a separate projects_root to test the new version</td>
<td>Install Insight 9.6 in a new location and copy your new license file to the &lt;projects_root&gt;/licenses directory in the new installation. Run a License Server for each installation.</td>
</tr>
<tr>
<td>Upgrade your existing projects_root</td>
<td>Append the contents of your new license file to the 8.x license file. Run only the License Server from the 8.x installation. You can specify that version 9.6 should use the previous License Server in one of two ways: • During installation, by specifying the appropriate host and port in the wizard or with the installation script. See Installing Klocwork Insight. • After installation, with kwservice set-service-property. See Viewing and changing Klocwork server settings.</td>
</tr>
<tr>
<td>Run separate production projects_roots for each version (for example, if one group is upgrading but another group needs to continue using version 8.x)</td>
<td>Install Insight 9.6 in a new location and copy your new license file to the &lt;projects_root&gt;/licenses directory in the new installation. Run a License Server for each installation.</td>
</tr>
</tbody>
</table>

Note: If you will use your organization’s FLEXlm license server rather than the license server packaged with Klocwork Insight, you must configure Insight and the FLEXlm license server to work together, and you must put your Klocwork license file in the right place. See Using your organization’s FLEXlm server.
Prepare to upgrade

For details on starting and stopping the servers, see Starting the Klocwork Servers and Stopping the Klocwork Servers.

To prepare to upgrade:

1. For the projects_root you wish to migrate, run:

   
   ```
   kwservice --projects-root <projects_root> check
   ```

2. Make note of what servers are running and what ports they are running on. After migration to the new version of Klocwork Insight, the servers will be running on these ports.

3. Stop the servers.

4. To create a restore point, perform a complete backup of any projects_root directories you want to migrate. After you upgrade Klocwork Insight, you cannot undo the upgrade. For information, see Backing up Klocwork data.

5. If you customized any configuration files (such as kwmysql.ini or kwfilter.conf), back up the <server_install>/config directory.

6. Start the servers.

7. **IMPORTANT:** To reduce the time required to migrate your Klocwork data, Klocwork strongly recommends that you:

   - Delete any projects from the previous version that you do not need to migrate. See kwadmin delete-project.
   - Delete any failed project builds from the previous version. You cannot resume a build that failed in a previous release after migrating the project as described in this article. However, you may be able to load the build from tables. See kwadmin delete-build.

8. If not running the Klocwork Servers as Windows services, stop the servers.

9. (Optional) To create a second restore point, back up the projects_root directories you have prepared for migration.

10. Store the existing Klocwork license in a safe place.

11. To prevent confusion, delete the old Klocwork logs from <projects_root>/logs.

If you are using a separate MySQL database server

The Klocwork Database Server is a MySQL 5.1.63 database server. If you want to use your own manually installed MySQL database server, it must be version 5.1.63. If necessary, upgrade your separate MySQL database before you install or upgrade Klocwork Insight.

Install the Insight Server package

Install the version 9.6 Server package. For instructions, see:

- Installing the Klocwork Server package on Windows -- Upgrade only
- Installing the Klocwork Server package on Unix -- Upgrade only
- Installing the Klocwork Server package on Mac -- Upgrade only
Validate your database (mandatory)

dbvalidate is a tool that checks the consistency of data in your database. It works on Insight versions 8.2 and later. Running this tool is mandatory, so that any errors in your database can be corrected before you migrate.

**Note:** The Database Server from your old installation must be running to validate the database.

Run the following command:

```
java -jar <9.6_server_install>/class/dbvalidate.jar --db <host> --port <port> [--password <password>]
```

*where*

- `<9.6_server_install>` is your new installation directory
- `<host>` is the host name of the Database Server hosting the data you want to validate (default: localhost)
- `<port>` is the port number for the Database Server hosting the data you want to validate (default: 3306)
- `<password>` is the password for your database; specify this option only if a password was assigned

**Examples**

```
java -jar C:/Klocwork/class/dbvalidate.jar --db TITAN --port 3308 --password secret_password
java -jar C:/Klocwork/class/dbvalidate.jar --db TITAN --port 3308
```

dbvalidate will report any errors between the "validation started" and "validation finished" lines:

```
Wed Jun 01 07:53:58 CDT 2011 kw_central database (version: 95) validation started
<detected errors appear here>
```

- **If Errors** are displayed, contact Klocwork Customer Support[4], so that we can correct the error prior to migration.
- **If no errors are displayed,** your database was successfully validated.

Put your new license in the correct directory

If you received a new license file from Customer Support, copy it to `<projects_root>/licenses`.

**Note:** See Customizing licensing for information on licensing options.

If you reserved licenses, create a new options file

Because license keys changed in Klocwork Insight 9.x, if you are upgrading from Insight 8.x and you were using an options file to reserve licenses for users or hosts, you will need to create a new options file. See Reserving licenses.

Migrate your Klocwork data

To migrate a `projects_root`, run the following command from `<Klocwork_9.6_Server_install>/bin`:

```
kwservice --projects-root <old_projects_root> start --migrate
```

If the `projects_root` migrates successfully, the Klocwork Servers start on the port numbers picked up from the migrated `projects_root`.

**Notes:**

- **If you will be running the Klocwork Servers as Windows services,** after starting the servers with the `--migrate` option, stop the servers with `kwservice --projects-root <migrated_projects_root> stop`. Then start the Insight 9.6 services in Windows Services Administration.
• You can manage the Klocwork servers remotely on Unix with SSH, or on Windows with Windows Services administration. Otherwise, you must issue the start, restart and stop commands locally.
• The above command converts all external configuration files in the projects_root to UTF-8. As of Klocwork Insight 8.1, all external configuration files must be UTF-8 encoded if they contain multibyte characters (for example, Japanese). External configuration files are those listed in Configuration files you can edit.

If you customized configuration or metrics files
• If you modified the MySQL configuration file located at
  <old_Klocwork_install>/config/kwmysql.ini
  Make the same changes to kwmysql.ini in the new installation.
  Note: The following fields are no longer supported with the version of MySQL used with Insight 9.2 and later. If your previous kwmysql.ini file contains these fields, do not copy these lines to the new file:
  - skip-bdb
  - myisam_max_extra_sort_file_size
  Important: Do not copy your customized configuration files into the new Insight installation. Instead, make the same customizations to the newly installed configuration files.
• If you modified the compiler mapping file located at
  <old_Klocwork_install>/config/kwfilter.conf
  Make the same changes to kwfilter.conf in the new installation.
  Important: Do not copy your customized configuration files into the new Insight installation. Instead, make the same customizations to the newly installed configuration files.
• The following files are obsolete as of Insight 9.5 and do not need to be migrated:
  • the compiler configuration file (kwcc_config.xml)
    See kwinject error - Compiler can't be configured for more information.
  • compiler filter files (<compiler_name>_filter.xml)
    You may need to contact Customer Support to replace your _filter.xml file with a Python script. See Adding an unsupported C/C++ compiler for details.
• If you added custom metrics reports to Klocwork Review, you need to edit the custom metrics report configuration file (metrics.xml). Prior to Klocwork Insight 9.0, the metrics.xml file was located at:
  <server_install>/webapps/review/reporting/config
• As of Klocwork Insight 9.0, the metrics.xml file is located at:
  <projects_root>/config

Notes
• As of Klocwork Insight 9.0, the metrics.xml file applies to a projects_root directory, not to an entire Klocwork installation. Therefore, if you have multiple projects_root directories, you will need to copy your customized metrics.xml file to each of your projects_roots.
• As of Klocwork Insight 9.0, you need to restart the Klocwork Server after customizing the metrics.xml file.
See Customizing metrics reports in Klocwork Review.
Test your upgrade

Ensure that you can see your projects and builds in Klocwork Review.

If you installed a new license file, ensure that it was installed correctly by checking that the number of licenses is correct.

Upgrade all client installations

Ensure that all Klocwork clients are upgraded to Insight 9.6. Clients earlier than Insight 9.6 cannot interoperate with an Insight 9.6 Server.

Before installing a new version of the Klocwork User package, uninstall the previous version. For Windows, the installation package will detect whether you have a previous version of the user package installed and automatically uninstall it.

If users will be running the installation package themselves, tell them the host and port information for the Klocwork Server and License Server, so that they can set it during installation.

See Installing Klocwork Insight for full information on installing the Klocwork User package.

Repeat upgrade steps on other projects_root directories

To migrate another projects_root, carry out the steps in this chapter again (except for installing Klocwork).

Summary of upgrade steps for second or later projects_root directory:
1. Prepare to upgrade.
2. Run:

   kwservice --projects-root <projects_root> start --migrate

3. Re-create any compiler configuration files you had customized.
4. If you added custom metrics reports to Klocwork Review, edit the custom metrics report configuration file (metrics.xml).
5. Test your upgrade.

Before your first version 9.6 integration build analysis

New releases of Insight normally have changes to the checker configuration to keep up with current events and respond to customer requests. These changes may mean that your checker configuration from the previous release isn't the same in the new release.

When you're migrating to a new release, the issues, status changes and comments from an analysis run in the previous release are propagated only during the first run in the new release. If any checkers are disabled by default in the new release, you can lose issues or status changes from the old analysis run, so it's important to run your first analysis with the same configuration as before.

To do this, make sure that you that have the right checkers enabled to match your old configuration. See Disabled C/C++ checkers in What's New, then make any changes to your checker configuration. After you're satisfied with your configuration, perform your first version 9.6 integration build analysis on unmodified source code.

Note: If you've already run your first 9.6 analysis and you're missing some issues or status changes, delete that build, reconfigure your checkers, and run a new analysis.

We recommend running your final pre-upgrade integration build analysis and your first version 9.6 analysis on identical source code, and then comparing the two builds. This allows you to assess changes in the analysis engine. For details on improved, added and removed checkers in this version, see What's New.
Installing the Klocwork Server package on Windows -- Upgrade only

This page provides instructions for installing the Server package if you are upgrading.

IMPORTANT: This is not the starting point for upgrading. Make sure you start with Upgrading from a previous version.

Before you begin

Where do I get the software?

Download the packages from Klocwork support. Typically, only one or two users in an organization have access to my.klocwork. If you don't have access, contact Klocwork Customer Support.

Required permissions

- Administrator access is required to install all Windows packages, whether using the installation wizard or unattended installation.
- You must have administrator access to install the Klocwork Server.
- You must have administrator permissions to start the Klocwork Servers (and to run the Klocwork Servers as Windows Services).
- For Windows Server 2008, you must use the 'Run As Administrator' option in order to launch any Klocwork tools which access a projects_root that is located on a root directory.

Run the installation wizard

Run the Klocwork Server installation wizard, following the prompts. Note the following:

- The installation package will automatically detect whether you have a 32-bit or 64-bit operating system and will install the appropriate version of Java.
- If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
- For information on the Use secure server connection (HTTPS) checkbox, see Using a secure Klocwork Server connection.
- When prompted for the location of the projects_root directory, specify the old projects_root directory that you want to migrate.
- You do not need to set host names and port numbers for the Klocwork Servers during installation. This information will be picked up from your old projects_root directory when it is migrated.
- Do not select the option to start the Klocwork Servers as Windows services automatically. You will start the servers in a later step.
- The Klocwork bin directory is automatically added to your System Path environment variable.
Log files

An installation log file is saved to the Temp directory of Local Settings whenever one of the Klocwork installation packages is started on Windows. For example, on Windows 7, the installation log file is saved to \Users\<user>\AppData\Local\Temp.

These log files are named Klocwork<release_number>-<package>.log. For example, the installation log file for the Klocwork 9.6 Server package is named Klocwork9.6-Server.log.

A logs directory is also created in the root Klocwork installation directory during installation. For the Server installer, for example, the log files in this directory store kwservice output when the servers are first started and the projects_root directory is initialized.

What's next?

Now it's time to validate your database.

References


Installing the Klocwork Server package on Unix -- Upgrade only

This page provides instructions for installing the Server package if you are upgrading.

IMPORTANT: This is not the starting point for upgrading. Make sure you start with Upgrading from a previous version.

Before you begin

Where do I get the software?

Download the packages from Klocwork support[1]. Typically, only one or two users in an organization have access to my.klocwork. If you don't have access, contact Klocwork Customer Support[4].

Installation notes

• Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the one that matches your operating system.
• Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate permissions:
  chmod 755 <kw-installer.sh>
• To control permissions when you are installing Klocwork, change the value of umask.
• Install Klocwork software as a non-root user.
• If your organization uses GCC, make sure the correct version of the compiler is in your PATH before you run the installation program. Including the GCC compiler in your PATH automatically creates default links to standard GCC libraries and defines for all the projects you create. Note that any user can override these defaults for a particular project or build by not including the standard libraries and defines. If your organization does not use GCC, do not include it in your PATH when you run the installation program.
• Ensure that the path in which you install the product is the same path from which users invoke the product. For example, the local path to the installation might be /local/tools/klocwork, but users on other machines have to use the NFS path /opt/tools/klocwork to invoke the product. Therefore, to ensure that users can
invoke the product, use the /opt/tools/klocwork path during installation.

- **Important:** Due to MySQL limitations, the projects_root directory should not be located on NFS. It has a special file locking implementation which is not fully supported by MySQL. See also the warning in the MySQL documentation \[1\].

## Run the installation package

Run the following command:

```bash
kw-server-installer-9.6.x.<platform>.sh -p <projects_root> [options] <install_directory> [component ...]
```

where

- `<platform>` is `solaris`, `linux` or `aix`
- `<projects_root>` is the location of the old projects_root directory that you want to migrate
- `[options]` are any of the options listed in Command-line options for the Server package

**Note:** You do not need to set host names and port numbers for the Klocwork Servers during installation. This information will be picked up from your old projects_root directory when it is migrated.

- `<install_directory>` specifies the directory in which you want to install Klocwork. Do not specify a subdirectory of the projects_root directory. Note that if the chosen directory is not empty, you will not be able to continue with the installation.
- `[<component ...>]` is any of the arguments from Arguments for Server components. Separate multiple components with spaces. If you do not specify one or more components, the entire package will be installed. You can also see a list of arguments for the various components with the `--list` option. Note that an asterisk in the returned output means the component is already installed.

### Example

```bash
kw-server-installer-9.6.0.0.linux.sh -p /space/old_projects_root /opt/klocwork
```

## Command-line options for the Server package

<table>
<thead>
<tr>
<th>Name</th>
<th>Short name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--agree</td>
<td>-a</td>
<td>Agree to license terms and do not display license agreement.</td>
</tr>
<tr>
<td>--database-port</td>
<td></td>
<td>Specify the port number that you will use to run the Database Server. Default: 3306. This option is equivalent to specifying the port number with kwservice.</td>
</tr>
<tr>
<td>--debug</td>
<td></td>
<td>Print debug information</td>
</tr>
<tr>
<td>--force</td>
<td>-f</td>
<td>Install without integrity checks</td>
</tr>
<tr>
<td>--help</td>
<td>-h</td>
<td>Display this help and exit</td>
</tr>
<tr>
<td>--klocwork-port</td>
<td></td>
<td>Specify the port number that you will use to run the Klocwork Server. Default: 8080. This option is equivalent to specifying the port number with kwservice.</td>
</tr>
<tr>
<td>--license-port</td>
<td></td>
<td>Specify that the License Server will be run locally, but on a non-default port. Default: 27000. This option is equivalent to specifying the port number with kwservice.</td>
</tr>
<tr>
<td>--license-server</td>
<td></td>
<td>Specify a remote License Server host. The host argument is required; the port argument is optional. Default: localhost:27000. This option is equivalent to specifying the host and port with kwservice. See also Using your organization's FLEXlm server.</td>
</tr>
<tr>
<td>--list</td>
<td>-l</td>
<td>List available features (components)</td>
</tr>
</tbody>
</table>
Installing the Klocwork Server package on Unix -- Upgrade only

---

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
</table>
| --projects-root <directory> | Specify the complete path to a non-default projects_root directory. Default: 
<install_directory>/projects_root. The directory you specify must meet one of the following conditions: 
• it does not yet exist 
• it is empty 
• it is a valid projects_root directory created previously 
Do not specify the same directory as the root Klocwork installation directory you have specified. Do not install Klocwork in a subdirectory of the projects_root directory. **IMPORTANT:** If you are upgrading, specify the old projects_root directory that you want to migrate. |
| --use-ssl | use a secure Klocwork server connection (HTTPS) |
| --version -v | display the version of Klocwork software and exit |

Arguments for Server components

<table>
<thead>
<tr>
<th>To install this Server component (feature)...</th>
<th>...enter the argument...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Server</td>
<td>DatabaseServer</td>
</tr>
<tr>
<td>License Server</td>
<td>LicenseServer</td>
</tr>
<tr>
<td>Klocwork Server</td>
<td>KlocworkServer</td>
</tr>
<tr>
<td>Administration and analysis management tools</td>
<td>BuildTools</td>
</tr>
</tbody>
</table>

Add Klocwork to your PATH

On Unix, we recommend adding <klocwork_install>/bin to your PATH. Otherwise, you need to execute commands from <klocwork_install>/bin.

What's next?

Now it's time to validate your database.

References

Installing the Klocwork Server package on Mac -- Upgrade only

This page provides instructions for installing the Server package if you are upgrading.

**IMPORTANT:** This is not the starting point for upgrading. Make sure you start with Upgrading from a previous version.

### Before you begin

**Where do I get the software?**

Download the packages from Klocwork support[1]. Typically, only one or two users in an organization have access to my.klocwork. If you don't have access, contact Klocwork Customer Support[4].

**Prerequisites**

- JVM versions: You must install JVM 1.6 Update 31 or later on your machine before installing the Klocwork Server or User package. If you have a previous JVM version installed and you try to install the Server or User package, you will see the error message, "Version of Java is too old". Apple supplies their own version of Java. Use the Software Update feature on your Mac.
- Access level: When installing the Mac packages, you must have administrator access.
- If your organization uses GCC, make sure the correct version of the compiler is in your PATH before you run the installation program. Including the GCC compiler in your PATH automatically creates default links to standard GCC libraries and defines for all the projects you create. Note that any user can override these defaults for a particular project or build by not including the standard libraries and defines. If your organization does not use GCC, do not include it in your PATH when you run the installation program.

### Running the installation package

Copy the Server installation package to your desktop and run it, following the prompts. Please note the following:

- All components of the Klocwork Server package are installed. You can't specify which components you want to install.
- On the Server Settings screen, when prompted for the location of the projects_root, specify the **old** projects_root directory that you want to migrate.
- You do not need to set host names and port numbers for the Klocwork Servers during installation. This information will be picked up from your old projects_root directory when it is migrated.
Installation directories

- The Server package is installed in the /Applications/ and /Library/Frameworks/ directories.
- Access command-line tools using the symbolic links in /usr/local/kw/.

Troubleshooting

Check the installation log from the Console (Applications > Utilities) or var/log/install.log.

What's next?

Now it's time to validate your database.
# Installing the Server package

## Installing Klocwork Insight

<table>
<thead>
<tr>
<th>Before you install:</th>
<th>System requirements</th>
<th>Release Notes</th>
<th>About the Klocwork packages and components</th>
</tr>
</thead>
</table>

### Server installation
- Getting a license
- Installing the Klocwork Server package on Windows
- Installing the Klocwork Server package on Unix
- Installing the Klocwork Server package on Mac
- Viewing and changing Klocwork server settings

### User/Client installation
- Installing the Klocwork User package on Windows
- Installing the Klocwork User package on Unix
- Installing the Klocwork User package on Mac

### For Eclipse users:
- Install the Klocwork plug-in from the Eclipse update site

### Upgrading
- Upgrading from a previous version
- Running a custom installation for new or upgraded IDEs
- Uninstalling Klocwork Insight

### Installation troubleshooting
- Error reading setup initialization file during installation
- Repairing a Windows installation of Klocwork Insight
- Find Klocwork Servers running on your LAN
- Unable to start the Database Server because the path to the socket file is too long
- Unable to start Klocwork Servers following Windows installation
- Database connection error
- Package Load Failure occurs in Visual Studio after I install patch
- IntelliJ IDEA installation not detected; plugin not installed
- Limitations for installation

### Additional installation topics
- Installing the Distributed Analysis package
- Unattended installation on Windows
- Testing your installation
Installing the Klocwork Server package on Windows

This page provides instructions for installing the Klocwork Server package using the installation wizard. For instructions on unattended installation of both the Klocwork Server and User packages, see Unattended installation on Windows.

You can either put the user packages where users can download and install them (“pull” installation) or, if your organization is set up for it, you can install the clients for your users in an unattended (“push”) installation through a Software Management System (SMS) or similar system. In the “pull” scenario, you need to let your developers know where they can access the User package.

Before you begin

Upgrading? See Upgrading from a previous version.

Where do I get the software?

Download the packages from Klocwork support [1]. Typically, only one or two users in an organization have access to my.klocwork. If you don’t have access, contact Klocwork Customer Support [4].

You need a license. See Getting a license if you don’t already have one.

Running two versions of the Klocwork Servers

If you will be running two sets of the Klocwork Servers, for example to test the Klocwork Insight 9.6 Servers while users continue to access your existing servers, you must run them on different projects_root directories (and set the ports appropriately).

Required permissions

• Administrator access is required to install all Windows packages, whether using the installation wizard or unattended installation.
• You must have administrator access to install the Klocwork Server.
• You must have administrator permissions to start the Klocwork Servers (and to run the Klocwork Servers as Windows Services).
• For Windows Server 2008, you must use the ‘Run As Administrator’ option in order to launch any Klocwork tools which access a projects_root that is located on a root directory.

Installation using the Windows installation wizard

Run the Klocwork Server installation wizard, following the prompts. Note the following:

• The installation package will automatically detect whether you have a 32-bit or 64-bit operating system and will install the appropriate version of Java.
• If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
• You can specify server information during installation in the Klocwork Servers configuration screen to override the default settings. The defaults for the License Server are localhost and 27000. The default port for the Klocwork Server is 8080. See Viewing and changing Klocwork server settings for more information on ports.
• For information on the Use secure server connection (HTTPS) checkbox, see Using a secure Klocwork Server connection.
• You’ll be asked where you want to create the projects_root directory, which is the data location for the Klocwork Servers and applications. It contains Klocwork Server settings and information about integration projects and
Installing the Klocwork Server package on Windows

build analysis runs. It also stores the Klocwork license file. The default location is
<server_install>\projects_root.

**Caution:** Do not install the Server package and the projects_root in the Program Files directory. Default security settings for Windows 7 and Windows Server 2008 restrict writing to files in the Program Files directory.

- During installation, you specify whether you want to use the locally installed License Server (*Local*) or connect to a remote License Server (*Remote*). *Local*, the default option, requires you to browse to your license file. If you select *Remote*, you must specify the host name and port number for your License Server.
- You have the option of starting the Klocwork Servers as Windows services automatically following installation. This option is available on the *Set up Klocwork Servers* dialog of the Server package installer. If you do not select this option, you need to start the servers manually following installation. See Start the servers below.

**Note on the Path environment variable**

On Windows, the Klocwork bin directory is automatically added to your Path environment variable as follows:

<table>
<thead>
<tr>
<th>Installation package</th>
<th>Environment variable modified</th>
<th>Value used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>System Path</td>
<td>&lt;server_install&gt;/bin</td>
</tr>
<tr>
<td>User</td>
<td>User Path</td>
<td>&lt;user_install&gt;/bin</td>
</tr>
</tbody>
</table>

**Log files for Windows installation**

An installation log file is saved to the Temp directory of Local Settings whenever one of the Klocwork installation packages is started on Windows. For example, on Windows 7, the installation log file is saved to \Users\<user>\AppData\Local\Temp.

These log files are named Klocwork<release_number>--<package>.log. For example, the installation log file for the Klocwork 9.6 Server package is named Klocwork9.6-Server.log.

A logs directory is also created in the root Klocwork installation directory during installation. For the Server installer, for example, the log files in this directory store kwservice output when the servers are first started and the projects_root directory is initialized.

**Start the servers**

If you did not already start the servers during installation, start them now, using Windows Services Administration or kwservice start:

```
kwservice --projects-root <projects_root> start
```

where `<projects_root>` is the projects_root directory you specified during installation

**Example**

```
kwservice --projects-root C:\klocwork\projects_root start
```
Next steps

Now you're ready to analyze your integration build.

Details: C/C++ | C# | Java

Unattended installation on Windows

This article covers unattended installation of both the Server and User packages on Windows.

Installing in unattended mode

To run an unattended installation of Klocwork Insight, enter the following command:

```
start /WAIT <installer.exe> /w /S [/l:<langid>] /v"/qn INSTALLDIR=<install_directory> <install_log> PROPERTY=VALUE PROPERTY1=VALUE1..."
```

where:

- `<installer.exe>` is the name of the installation package you want to use, for example,
  `kw-server-installer.9.6.0.0.windows.exe`
- `/w` parameter will cause the parent process to wait for the installation process. See the InstallShield help library [1] for more information on this.
  
  **Note:** The `%errorlevel%` system variable can be used to check for installation success.
- `/l:<langid>` allows you to change the default language for the installation package. By default, if your system locale is Japanese, the installation package will run in Japanese. Otherwise, it will run in English. To specify Japanese, use `/l:1041`.
- `/v` passes subsequent parameters directly to the MSI engine. The entire string after `/v` must be surrounded by quotation marks.
- `/qn` runs the installer in unattended mode
- `<install_directory>` is the absolute path to the directory in which you want to install Klocwork Insight. The default is the root directory of the local drive with the most available space.
  `%LOCAL_DRIVE%\Klocwork\<package>`, where `<package>` can be Server or User. Note that if the chosen directory is not empty, you will not be able to continue with the installation.
- `PROPERTY=VALUE` is any of the Allowable PROPERTY=VALUE pairs for unattended installation
  
  **Note:** Surround any value that contains spaces with escaped quotation marks (".").

Example

```
start /WAIT kw-server-installer.9.6.0.0.windows.exe /w /S /v"/qn INSTALLDIR="D:\Klocwork\Server 9.6" C:\Klocwork\server.log"
```
Installing specific components in unattended mode

To install one or more specific Klocwork Insight components (for example, to install Klocwork Desktop C/C++ Plug-in for Visual Studio or Klocwork Architect) in an unattended installation, include ADDLOCAL=<component_arguments> in your command line, where <component_arguments> is one or more arguments from the following tables. Multiple arguments must be separated by commas.

<table>
<thead>
<tr>
<th>To install this Server component (feature)…</th>
<th>…enter the argument…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Server</td>
<td>DatabaseServer</td>
</tr>
<tr>
<td>License Server</td>
<td>LicenseServer</td>
</tr>
<tr>
<td>Klocwork Server</td>
<td>KlocworkServer</td>
</tr>
<tr>
<td>Administration and analysis management tools</td>
<td>BuildTools</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To install this User component (feature)…</th>
<th>…enter the argument…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Klocwork Architect</td>
<td>Architect</td>
</tr>
<tr>
<td>Klocwork command line tools (for developers; includes Klocwork Desktop)</td>
<td>CommandLineTools</td>
</tr>
<tr>
<td>Klocwork Desktop C/C++ Plug-in for Visual Studio 2010</td>
<td>KC_VS2010</td>
</tr>
<tr>
<td>Klocwork Desktop Java or C/C++ Plug-in for Eclipse</td>
<td>Eclipse</td>
</tr>
<tr>
<td>Klocwork Desktop Java Plug-in for IntelliJ IDEA</td>
<td>KJ_IDEA</td>
</tr>
</tbody>
</table>

Allowable PROPERTY=VALUE pairs for unattended installation

Server package

<table>
<thead>
<tr>
<th>PROPERTY=VALUE</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDLOCAL=&lt;component_list&gt;</td>
<td>Installs specific components only. See tables in previous section for allowable values for this property.</td>
</tr>
<tr>
<td>INSTALLDIR=&lt;install_directory&gt;</td>
<td>Install into the directory you specify. Default: current working directory. Note that if the chosen directory is not empty, you will not be able to continue with the installation.</td>
</tr>
<tr>
<td>PROJECTS_ROOT=&lt;projects_root_directory&gt;</td>
<td>Set up a projects_root directory in the directory you specify. The default is &lt;Server_install&gt;/projects_root. Specify the complete path. IMPORTANT: If you are upgrading, specify the old projects_root directory that you want to migrate.</td>
</tr>
<tr>
<td>LICENSE_HOST=&lt;host_name&gt;</td>
<td>Specify License Server host name. Default: localhost</td>
</tr>
<tr>
<td>LICENSE_PORT=&lt;port_number&gt;</td>
<td>Specify License Server port number. Default: 27000</td>
</tr>
<tr>
<td>MYSQL_HOST=&lt;host_name&gt;</td>
<td>Specify Database Server host name. Default: localhost</td>
</tr>
<tr>
<td>MYSQL_PORT=&lt;port_number&gt;</td>
<td>Specify Database Server port number. Default: 3306</td>
</tr>
<tr>
<td>KWSERVER_HOST=&lt;host_name&gt;</td>
<td>Specify Klocwork Server host name. Default: localhost</td>
</tr>
<tr>
<td>KWSERVER_PORT=&lt;port_number&gt;</td>
<td>Specify Klocwork Server port number. Default: 8080</td>
</tr>
<tr>
<td>USE_SSL=1</td>
<td>To use a secure Klocwork Server connection, set this value to 1. Default: 0</td>
</tr>
</tbody>
</table>

Note: The Server Installer also supports the ALLUSERS property. For details, see this MSDN article [2].

User package
Unattended installation on Windows

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDLOCAL=&lt;component_arguments&gt;</td>
<td>Installs specific components only. See tables in previous section for allowable values for this property.</td>
</tr>
<tr>
<td>CREATE_SHORTCUTS=&quot;&quot;&quot;</td>
<td>Suppress creation of desktop shortcuts. Default: 1 (create shortcuts)</td>
</tr>
<tr>
<td>IDEAINSTALLDIR=&lt;directory&gt;</td>
<td>The directory where IntelliJ IDEA is installed</td>
</tr>
<tr>
<td>INSTALLDIR=&lt;directory&gt;</td>
<td>Install into the directory you specify. Default: current working directory. Note that if the chosen directory is not empty, you will not be able to continue with the installation.</td>
</tr>
<tr>
<td>LICENSE_HOST=&lt;host_name&gt;</td>
<td>Use License Server running at &lt;host_name&gt;</td>
</tr>
<tr>
<td>LICENSE_PORT=&lt;port_number&gt;</td>
<td>Use License Server running at &lt;port_number&gt;</td>
</tr>
<tr>
<td>KWSERVER_HOST=&lt;host_name&gt;</td>
<td>Use Klocwork Server running at &lt;host_name&gt;</td>
</tr>
<tr>
<td>KWSERVER_PORT=&lt;port_number&gt;</td>
<td>Use Klocwork Server running at &lt;port_number&gt;</td>
</tr>
<tr>
<td>USE_SSL=1</td>
<td>To use a secure Klocwork Server connection, set this value to 1. Default: 0</td>
</tr>
</tbody>
</table>

References

Installing the Klocwork Server package on Unix

Before you begin
Upgrading? See Upgrading from a previous version.

Where do I get the software?
Download the packages from Klocwork support [1]. Typically, only one or two users in an organization have access to my.klocwork. If you don't have access, contact Klocwork Customer Support [4].

You need a license. See Getting a license if you don't already have one.

Running two versions of the Klocwork Servers
If you will be running two sets of the Klocwork Servers, for example to test the Klocwork Insight 9.6 Servers while users continue to access your existing servers, you must run them on different projects_root directories.

Installation notes
• Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the one that matches your operating system.
• Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate permissions:
  chmod 755 <kw-installer.sh>
• To control permissions when you are installing Klocwork, change the value of umask.
• Install Klocwork software as a non-root user.
• If your organization uses GCC, make sure the correct version of the compiler is in your PATH before you run the installation program. Including the GCC compiler in your PATH automatically creates default links to standard GCC libraries and defines for all the projects you create. Note that any user can override these defaults for a particular project or build by not including the standard libraries and defines. If your organization does not use GCC, do not include it in your PATH when you run the installation program.
Installing the Klocwork Server package on Unix

- Ensure that the path in which you install the product is the same path from which users invoke the product. For example, the local path to the installation might be `/local/tools/klocwork`, but users on other machines have to use the NFS path `/opt/tools/klocwork` to invoke the product. Therefore, to ensure that users can invoke the product, use the `/opt/tools/klocwork` path during installation.
- **Important:** Due to MySQL limitations, the projects_root directory should not be located on NFS. It has a special file locking implementation which is not fully supported by MySQL. See also the warning in the MySQL documentation[1].

### Running the installation package

Run the following command:

```
kw-server-installer-9.6.x.x.<platform>.sh [options] <install_directory> [component ...]
```

*where*

- `<platform>` is `solaris`, `linux` or `aix`
- `[options]` are any of the options listed in Command-line options for the Server package.
- `<install_directory>` specifies the directory in which you want to install Klocwork. Do not specify a subdirectory of the projects_root directory. Note that if the chosen directory is not empty, you will not be able to continue with the installation.
- `[<component ...>]` is any of the arguments from Arguments for Server components. Separate multiple components with spaces. If you do not specify one or more components, the entire package will be installed. You can also see a list of arguments for the various components with the `--list` option. Note that an asterisk in the returned output means the component is already installed.

**Example: Installing only the Database Server component on Linux**

```
kw-server-installer-9.6.0.0.linux.sh -p /space/projects_root /opt/klocwork DatabaseServer
```

*where*

- `/space/projects_root` specifies the projects_root location. The default is `<Server_install>/projects_root`. For more information, see About the projects_root directory.
- `/opt/klocwork` specifies the directory in which you want to install the Database Server
- `DatabaseServer` indicates that only the Database Server component is to be installed

### Command-line options for the Server package

<table>
<thead>
<tr>
<th>Name</th>
<th>Short name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--agree</td>
<td>-a</td>
<td>Agree to license terms and do not display license agreement.</td>
</tr>
<tr>
<td>--database-port</td>
<td></td>
<td>Specify the port number that you will use to run the Database Server. Default: 3306. This option is equivalent to specifying the port number with kwservice.</td>
</tr>
<tr>
<td>--debug</td>
<td></td>
<td>Print debug information</td>
</tr>
<tr>
<td>--force</td>
<td>-f</td>
<td>Install without integrity checks</td>
</tr>
<tr>
<td>--help</td>
<td>-h</td>
<td>Display this help and exit</td>
</tr>
<tr>
<td>--klocwork-port</td>
<td></td>
<td>Specify the port number that you will use to run the Klocwork Server. Default: 8080. This option is equivalent to specifying the port number with kwservice.</td>
</tr>
<tr>
<td>--license-port</td>
<td></td>
<td>Specify that the License Server will be run locally, but on a non-default port. Default: 27000. This option is equivalent to specifying the port number with kwservice.</td>
</tr>
</tbody>
</table>
## Arguments for Server components

<table>
<thead>
<tr>
<th>Server component (feature)</th>
<th>Enter the argument</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Server</td>
<td>DatabaseServer</td>
</tr>
<tr>
<td>License Server</td>
<td>LicenseServer</td>
</tr>
<tr>
<td>Klocwork Server</td>
<td>KlocworkServer</td>
</tr>
<tr>
<td>Administration and analysis</td>
<td>BuildTools</td>
</tr>
</tbody>
</table>

## Add Klocwork to your PATH

On Unix, we recommend adding `<klocwork_install>/bin` to your PATH. Otherwise, you need to execute commands from `<klocwork_install>/bin`.

## Copy the license file

Copy your license file to the following location:

```
<projects_root>/licenses
```

The license file must have the extension `.lic`.

**Note**: See Customizing licensing for licensing options such as using your organization's license server.

## Start the servers

Start the servers with `kwservice` start:

```
kwservice --projects-root <projects_root> start
```

*where* `<projects_root>` is the projects_root directory you specified during installation

**Example**

```
kwservice --projects-root /space/klocwork/projects_root start
```

You see messages indicating that the servers have been started, showing the server host name and port number and the path to the projects_root. For example:

```bash
[...]
admin@klocwork.klocwork.com:27000 - Listening for connections to projects_root:/space/klocwork/projects_root
[...]
```
Installing the Klocwork Server package on Unix

Using projects root: /space/klocwork/projects_root
Local Host is: serverxyz.com [13.1.1.142]
Starting License Server [started on serverxyz.com:27000] (projects root is /space/klocwork/projects_root)
Starting Database Server [started on serverxyz.com:3306] (projects root is /space/klocwork/projects_root)
Starting Klocwork Server [started on serverxyz.com:8080] (projects root is /space/klocwork/projects_root)

Next steps
Now you're ready to analyze your integration build.

Details: C/C++ | C# | Java

Installing the Klocwork Server package on Mac

This page provides instructions for installing the Klocwork Server package using the installer.

Before you begin
Upgrading? See Upgrading from a previous version.

Where do I get the software?
Download the packages from Klocwork support [1]. Typically, only one or two users in an organization have access to my.klocwork. If you don't have access, contact Klocwork Customer Support [4].

You need a license. See Getting a license if you don't already have one.

Prerequisites
• JVM versions: You must install JVM 1.6 Update 31 or later on your machine before installing the Klocwork Server or User package. If you have a previous JVM version installed and you try to install the Server or User package, you will see the error message, “Version of Java is too old”. Apple supplies their own version of Java. Use the Software Update feature on your Mac.
• Access level: When installing the Mac packages, you must have administrator access.
• If your organization uses GCC, make sure the correct version of the compiler is in your PATH before you run the installation program. Including the GCC compiler in your PATH automatically creates default links to standard GCC libraries and defines for all the projects you create. Note that any user can override these defaults for a particular project or build by not including the standard libraries and defines. If your organization does not use GCC, do not include it in your PATH when you run the installation program.
Default settings and installation directories

- The Klocwork Server and User packages are installed in the /Applications/ and /Library/Frameworks/ directories.
- Access command-line tools using the symbolic links in /usr/local/kw/.
- The projects_root directory installs to /Users/Shared/Klocwork/ProjectsRoot/ by default.
- The Klocwork Servers are set to localhost, running on the default ports.

You can override server settings and specify where the projects_root is created during installation.

Note: All components of the Klocwork Server and User packages are installed. You can't specify which components you want to install.

Running the installation package

Copy the Klocwork Server installation package to your desktop and run it, following the prompts. Please note the following:

- The Server Settings screen is where you can adjust:
  - the location of the projects_root directory
  - ports for the Klocwork and Database Servers
- During installation, you specify whether you want to use the locally installed License Server (Local) or connect to a remote License Server (Remote). Local, the default option, requires you to browse to your license file. If you select Remote, you must specify the host name and port number for your License Server.

Troubleshooting

Check the installation log from the Console (Applications > Utilities) or var/log/install.log.

Start the servers

Start the servers with kwservice start:

```
kwservice --projects-root <projects_root> start
```

where <projects_root> is the projects_root directory you specified during installation

Example

```
kwservice --projects-root /space/klocwork/projects_root start
```

You see messages indicating that the servers have been started, showing the server host name and port number and the path to the projects_root. For example:

```
Using projects root: /space/klocwork/projects_root
Local Host is: serverxyz.com [13.1.1.142]
Starting License Server [started on serverxyz.com:27000] (projects root is /space/klocwork/projects_root)
Starting Database Server [started on serverxyz.com:3306] (projects root is /space/klocwork/projects_root)
Starting Klocwork Server [started on serverxyz.com:8080] (projects root is /space/klocwork/projects_root)
```
Next steps

Now you're ready to analyze your integration build.

Details: C/C++ | C# | Java

kwupdate

The kwupdate command for Unix lists installed components and installs/uninstalls patches.

Note: If you did not install a particular component with the installation package, it's not possible to install that component later with kwupdate. In order to install another component of the Klocwork tools, you must re-run the appropriate Server or User installation package.

Synopsis

List installed patches

```
kwupdate [<options>] --list-updates
```

List installed components

```
kwupdate [<options>] --list
```

Install a previously uninstalled patch

You normally install a patch by running a self-extracting patch installer script, for example, RP9.5.0.XXXX-linux-9.5.0.YYYY.sh. You would only run the following command to install a previously uninstalled patch.

```
kwupdate [<options>] --install --sequence <patch_number> ALL
```

where

- `<options>` are any of the options from the table below
- `<patch_number>` is the number of the patch you want to reinstall
- ALL means apply the patch to all installed components

Example

```
kwupdate --install --sequence 11269 ALL
```

Uninstall a patch

```
kwupdate [<options>] --uninstall --sequence <patch_number> ALL
```

where

- `<options>` are any of the options from the table below
- `<patch_number>` is the number of the patch you want to uninstall
- ALL means uninstall the patch from all installed components

Example

```
kwupdate --uninstall --sequence 11269 ALL
```
## Options

<table>
<thead>
<tr>
<th>Name</th>
<th>Short name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--config &lt;file&gt;</td>
<td>-C</td>
<td>use this configuration file (default is <code>/etc/kwupdate.conf</code>)</td>
</tr>
<tr>
<td>--define &lt;name&gt;=&lt;value&gt;</td>
<td>-D</td>
<td>define a variable with the specified value. Some packages use variables to keep track of important information. For example, the IntelliJ IDEA plugin requires the &quot;idea.home&quot; variable to be set to the IntelliJ IDEA home directory.</td>
</tr>
<tr>
<td>--help</td>
<td>-h</td>
<td>print this help and exit</td>
</tr>
<tr>
<td>--idea-dir &lt;dir&gt;</td>
<td></td>
<td>IntelliJ IDEA home directory. Equivalent to <code>--define idea.home=&lt;dir&gt;</code></td>
</tr>
<tr>
<td>--install</td>
<td>-i</td>
<td>install previously uninstalled patches. Use <code>--sequence</code> to specify patch numbers.</td>
</tr>
<tr>
<td>--list</td>
<td>-l</td>
<td>list installed components</td>
</tr>
<tr>
<td>--list-updates</td>
<td></td>
<td>list installed updates</td>
</tr>
<tr>
<td>--no-saved-variables</td>
<td>-N</td>
<td>do not use or update remembered variable values. Normally, when a variable is set, its value is saved in the kwupdate database, so that you do not have to re-type the same variables. This option instructs kwupdate to ignore saved variable values and not to update the kwupdate internal database with new variable values.</td>
</tr>
<tr>
<td>--quiet</td>
<td>-q</td>
<td>print as little as possible (only errors and warnings)</td>
</tr>
<tr>
<td>--sequence &lt;num&gt;</td>
<td>-n</td>
<td>specify update sequence number (use with <code>--install</code>, <code>--uninstall</code>). Separate multiple patch numbers with spaces.</td>
</tr>
<tr>
<td>--uninstall</td>
<td>-u</td>
<td>remove installed patch(es). Use <code>--sequence</code> to specify patch numbers.</td>
</tr>
<tr>
<td>--version</td>
<td>-v</td>
<td>print version and exit</td>
</tr>
</tbody>
</table>
Installing the User package

Installing the Klocwork User package on Windows

This article provides instructions on using the installation wizard. For unattended installation, see Unattended installation on Windows.

Before you begin

- The installation package will detect whether you have a previous version of the user package installed and automatically uninstall it.
- By default, the Klocwork User package will install for all users on a single machine.
- You can only have one installation the Klocwork User package on a machine (regardless of the version). If you run the Klocwork User package again, the installation wizard will ask you if you want to remove or modify the previous installation.
- You can specify information for the Klocwork Servers during installation in the Klocwork Servers configuration screen to override the default settings. The defaults for the License Server are localhost and 27000. The default port for the Klocwork Server is 8080.
- You must have administrator access to your machine to install the Klocwork User package.

For limitations related to installation, see the Release Notes.

Running the installation wizard

The Windows Klocwork User package is called kw-user-installer.9.6.x.x.windows.exe. For more information about the components, see About the Klocwork packages and components.

- If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
- The installation package will automatically detect whether you have a 32-bit or 64-bit operating system and will install the appropriate version of Java.
- Destination Directory screen: The default destination directory is the local drive with the most available space. For example:
  D:\Klocwork\User 9.6\
- Klocwork Servers configuration screen: Specify the Klocwork Server information provided by your Klocwork administrator. Select Use secure server connection (HTTPS) if a secure Klocwork Server connection has been configured.
Troubleshooting

- If you have trouble installing the IntelliJ IDEA plugin, see IntelliJ IDEA installation not detected; plugin not installed.
- See also the main Troubleshooting page.

What's next?

- Eclipse users need to install the Klocwork plug-in from the Eclipse update site.
- Go to Fixing issues before check-in with Klocwork Desktop Analysis and choose your development environment.

Installing the Klocwork User package on Unix

Before you begin

- Before installing a new version of the Klocwork User package, uninstall the previous version.
- Check the System requirements.
- To control permissions when you are installing Klocwork Insight, change the value of umask.
- To change the permissions on an existing installation, use chmod.
- Install Klocwork software as a non-root user.
- **Linux only:** There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the one that matches your operating system.

Installing Klocwork User on Unix

Run the following command:

```
kw-user-installer-9.6.x.x.<platform>.sh [options] <install_directory> [component ...]
```

**where**

- `<platform>` is either `solaris` or `linux` or `linux64` if you are using 64-bit Linux
- `<options>` are any of the options listed in Command-line options for the User package on Unix.
  - **Note:** If you want to install the Klocwork Desktop Java Plug-in for IntelliJ IDEA, you must use the `--idea-dir` option.
- `<install_directory>` specifies the directory in which you want to install Klocwork Insight. Note that if the chosen directory is not empty, you will not be able to continue with the installation.
- `[component ...]` is any of the arguments from Arguments for User components on Unix. Separate multiple components with spaces. If you do not specify one or more components, the entire package will be installed. You can also see a list of arguments for the various components with the `--list` option. Note that an asterisk in the returned output means the component is already installed.
Installing the Klocwork User package on Unix

**Example 1: Installing the entire Klocwork User package on Solaris**

```
kw-user-installer-9.6.1.1.solaris.sh -a /home/jlee/klocwork
```

*where*

- `-a` means that you agree to the terms of the Klocwork license
- `/home/jlee/klocwork` specifies where Klocwork Insight will be installed

**Example 2: Installing the Command Line Tools component on Linux**

```
kw-user-installer.9.6.1.1.linux64.sh -a /home/jlee/klocwork CommandLineTools
```

The example above uses:

- `-a` to agree to the license without displaying the license agreement
- `/home/jlee/klocwork` specifies where Klocwork Insight will be installed
- `CommandLineTools` argument to install only the command-line feature from the User package.

**Tip:** You can specify the Klocwork Server (if you will be connecting to a server project) or the License Server (for standalone projects) during installation by using the appropriate Unix installer command-line options.

**Example 3: Installing Klocwork Desktop Plug-in for Eclipse on Linux**

```
kw-user-installer-9.6.1.1.linux64.sh -a /home/jlee/Eclipse
```

*where*

- `-a` means that you agree to the terms of the Klocwork license
- `/home/jlee/Klocwork` specifies where Klocwork Insight will be installed
- `Eclipse` indicates that only Klocwork for Eclipse feature is to be installed

**Example 4: Installing Klocwork Desktop Plug-in for IntelliJ IDEA on Linux**

```
kw-user-installer-9.6.1.1.linux64.sh --idea-dir "~/JetBrains/IntelliJ IDEA 9.0" /opt/klocwork/user 9.6" KJ_IDEA
```

*where*

- `-a` means that you agree to the terms of the Klocwork license
- "~/JetBrains/IntelliJ IDEA 9.0" specifies where IntelliJ IDEA is installed on your machine
- "~/opt/klocwork/user 9.6" is the path to the Klocwork user install directory
- `KJ_IDEA` indicates that only the Klocwork Desktop Java Plug-in for IntelliJ IDEA is to be installed

**Command-line options for the User package on Unix**
### Arguments for User components on Unix

<table>
<thead>
<tr>
<th>Name</th>
<th>Short name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--agree</td>
<td>-a</td>
<td>agree to license terms and do not display license agreement</td>
</tr>
<tr>
<td>--force</td>
<td>-f</td>
<td>install without integrity checks</td>
</tr>
<tr>
<td>--help</td>
<td>-h</td>
<td>display this help and exit</td>
</tr>
<tr>
<td>--idea-dir</td>
<td></td>
<td>specify the directory where IntelliJ IDEA is installed (applicable only if you are installing Klocwork Insight Java Plug-in for IntelliJ IDEA)</td>
</tr>
<tr>
<td>--klocwork-server &lt;host&gt;:&lt;port&gt;</td>
<td></td>
<td>specify the Klocwork Server host name and port number. Default: localhost:8080.</td>
</tr>
<tr>
<td>--license-server &lt;host&gt;:&lt;port&gt;</td>
<td></td>
<td>specify the License Server host name and port number. Default: localhost:27000</td>
</tr>
<tr>
<td>--list</td>
<td>-l</td>
<td>list available features (components)</td>
</tr>
<tr>
<td>--use-ssl</td>
<td></td>
<td>use a secure Klocwork Server connection</td>
</tr>
<tr>
<td>--version</td>
<td>-v</td>
<td>display the version of Klocwork software and exit</td>
</tr>
</tbody>
</table>

### Add the bin directory to your PATH

We recommend adding the `<user_install>/bin` directory to your PATH environment variable. Procedures in the documentation assume that you have added the bin directory to your PATH.

### Troubleshooting

- Package Load Failure occurs in Visual Studio after I install patch
- IntelliJ IDEA installation not detected; plugin not installed
- Error reading setup initialization file during installation

### What's next?

- Eclipse users need to install the Klocwork plug-in from the Eclipse update site.
- Go to Fixing issues before check-in with Klocwork Desktop Analysis and choose your development environment.
Installing the Klocwork User package on Mac

Before you begin
Typically, the Klocwork administrator makes the User package available to developers in a centralized tools directory. If you're not sure where the package is located, ask the administrator.
Before installing a new version of the Klocwork User package, uninstall the previous version.

Prerequisites
• **JVM version:** You must install JVM 1.6 Update 31 or later on your machine before installing the Klocwork Server or User package. If you have a previous JVM version installed and you try to install the Server or User package, you will see the error message, "Version of Java is too old". Apple supplies their own version of Java. Use the Software Update feature on your Mac.
• **Access level:** When installing the Mac packages, you must have administrator access.

Using the installer GUI
To install, simply copy the installation package to your desktop and run it, following the prompts.
Notes:
• The User package installs in the following directories:
  • /Applications/Klocwork User 9.6/
  • /Library/Frameworks/KlocworkUser.framework/Versions/9.6/
• All applications in the User package are installed. You can't do a custom installation.
• Access command-line tools using the symbolic links in /usr/local/kw/.

What's next?
• If you're an Eclipse user, install the Klocwork plug-in from the Eclipse update site.
• If you're an intelliJ IDEA user, see Getting started with Klocwork Desktop Java Plug-in for IntelliJ IDEA.
• If you're using an IDE or editor not supported with a Klocwork plug-in, see Getting started with kwcheck for Java.
Installing the Klocwork plug-in from the Eclipse update site

If you installed the Klocwork plug-in for Eclipse from the Klocwork User package, you also need to install the Eclipse update site and specify the path to the Klocwork installation directory in Eclipse.

Install the update site in Eclipse

Follow the instructions according to the version of Eclipse you're using:

<table>
<thead>
<tr>
<th>Eclipse 3.4</th>
<th>Eclipse 3.5, 3.6, 3.7 and 4.2</th>
</tr>
</thead>
</table>
| 1. In Eclipse, go to Help > Software Updates.  
2. Click the Available Software tab.  
3. Click Add Site and then click Archive. | 1. In Eclipse, go to Help > Install New Software.  
2. Click Add.  
3. Click Archive. |

Wind River Workbench: Select the Advanced Device Development perspective (the button near the upper right) to access Help > Software Updates.

   Tip: On Mac, Klocwork is installed at `/Library/Frameworks/KlocworkUser.framework/Versions/9.6/`
5. Click Open.
6. Click OK.

The update site is added to the list of sites to search.

Next, install the update site:

<table>
<thead>
<tr>
<th>Eclipse 3.4</th>
<th>Eclipse 3.5, 3.6, 3.7 and 4.2</th>
</tr>
</thead>
</table>
| 1. Click Install.  
2. Click Finish.  
3. When you are prompted to restart Eclipse, click Yes. | 1. Add a check to Static Analysis Tools if you want to install both Klocwork for C/C++ and Klocwork for Java. Otherwise expand Static Analysis Tools and add a check to your preferred language. Then click Next.  
Note: Install the plug-in that reflects the language of your installed development tools. For example, if you are only using JDT, then only install Klocwork for Java.  
2. In Install Details, click Finish.  
3. When you are prompted to restart Eclipse, click Yes. |

Specify the path to the user installation directory

1. Go to Window > Preferences.
2. Expand Klocwork and click Settings.
3. Click the Browse button next to Path to User Klocwork installation and browse to the Klocwork User installation directory. For example:
   D:\Klocwork\User 9.6
   Tip: On Mac, Klocwork is installed at  
   `/Library/Frameworks/KlocworkUser.framework/Versions/9.6/`
4. Click OK.
What's next?
To get started with a Klocwork desktop analysis, go to one of the following:

• Getting started with Klocwork Desktop C/C++ Plug-in for Eclipse
• Getting started with Klocwork Desktop Java Plug-in for Eclipse

Running a custom installation for new or upgraded IDEs

If, after you installed Klocwork Insight, you upgraded your IDE, you must uninstall the previous version of the plug-in. For uninstallation information, see Uninstalling Klocwork Insight.

After uninstalling, either:

• re-run the Klocwork User installer and selectively install the plug-in version that you need (for example, if you've gone from Visual Studio 2005 to 2010), or
• install the update site from the <user_install>/update-site directory and set the path to your installation directory in your new version of Eclipse

If you're using Klocwork Desktop Command Line or Klocwork Desktop, you don't have to do anything further.

Upgrade steps are provided below, by IDE plug-in.

Visual Studio
Just re-run the Klocwork User package installer on Windows. The installer automatically detects installed versions of Visual Studio on your machine.
Deselect features you don't want installed.

Eclipse
Regardless of the Eclipse version you upgraded to, you need to:
1. Install the Klocwork plug-in from the Eclipse update site.
2. Specify the path to the user installation directory.

IntelliJ IDEA
If you installed the upgraded version of IntelliJ IDEA in the same directory, you don't need to do anything further.
If you installed IDEA to a different location:

• Windows:
  Re-run the Windows installer and deselect features you don't want installed on your machine.
  During installation, Klocwork Insight automatically detects your IntelliJ IDEA directory and installs the plug-in directory to that location. If more than one IDEA installation directory is detected, you have to browse to the preferred location.
• Linux:
  Run the following command:

  <kw-user-installer> --idea-dir <intellij_install_location> <user_install> KJ_IDEA
where

- `<kw-user-installer>` is the name of the Klocwork installer executable
- `<intellij_install_location>` specifies where IntelliJ IDEA is installed on your system
- `<user_install>` is the directory where you want to install Klocwork. Note that if the chosen directory is not empty, you will not be able to continue with the installation.
- KJ_IDEA specifies that only the IntelliJ IDEA plug-in will be installed

Example:

```bash
kw-user-installer.9.x.x.x.linux.sh --idea-dir jlee/JetBrains/IntelliJIDEA /home/jlee/Klocwork KJ_IDEA
```
Installing the Distributed Analysis package

Installing the Distributed Analysis package

The Distributed Analysis components are available as a separate Klocwork installation package (for example, on Linux, the package is kw-dist-build-installer.9.x.x.xx.linux.sh).

Installing on Unix

To install the complete Klocwork Distributed Analysis package on Unix:

1. Download the Klocwork Distributed Analysis installation package for your operating system to a temporary directory.
2. Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate permissions. Enter:

   ```bash
   chmod 755 <executable-name>
   ```

   **Note:** Install Klocwork software as a non-root user.
3. Run the executable with the options and arguments you want.

   ```bash
   <kw-dist-analysis-installer> -a -i <install_directory>
   ```

   *where:*
   - `<kw-dist-analysis-installer>` is the name of the installation executable
   - `-a` indicates that you accept the license agreement
   - `<install_directory>` is the absolute path to the location in which you want to install the Distributed Analysis package

Installing on Windows

On Windows, you can use the installation wizard or perform an unattended installation.

To install the Klocwork Distributed Analysis package on Windows, you must have administrator permissions for the machine you want to install on.

**Note:** The Klocwork User package automatically installs for all users on a single machine.

Installing Klocwork with the installation wizard

To install the Klocwork Insight Distributed Analysis package or its components on a local machine:

1. Download the Klocwork Distributed Analysis package for Windows to a temporary directory.
2. Run the installation executable.
   - The graphical user interface initializes and prepares.
   - The Welcome screen of the wizard appears.
3. Click **Next**.
   - The License Agreement screen appears.
4. Review the license agreement, and, if you agree, click "I accept the terms of the license agreement".
5. Click **Next**.
   
The "Destination Directory" screen appears.
   
The default destination directory is the local drive with the most available space. For example:
   
   D:\Klocwork\Distributed Analysis 9.6\n   
6. Click **Next** to accept the default folder or click **Change...** to install Klocwork in a different location.
   
   If you click **Change...**, the Change Current Destination Folder screen appears. Browse to the folder where you want to install Klocwork.
   
   **Important**: Avoid installing the package in the Program Files directory on Windows Vista, Windows Server 2008 and Windows 7 machines. Windows User Access Control (UAC) restricts writing to the Program Files directory.
   
7. Click **OK**.
    
8. Click **Next**.
   
   The Setup Type screen appears.
   
   By default, the Complete button is selected.
   
9. To install the entire Klocwork Distributed Analysis package on one machine, leave the **Complete** button selected and go to step 11.
   
   To select one component to install on this machine, click **Custom** and click **Next**.
   
   The Custom Setup screen appears, showing two choices.
   
   **Note**: In the Windows installation wizard, the term "feature" means "component".
   
   If there is a component you do not want to install on this machine, click the icon of the component and click **This feature will not be available**. Any components you do not disable will be installed. Click off **Klocwork Distributed Analysis Server** or **Klocwork Distributed Analysis Agent**, depending on which component you do not wish to install.
   
   **Important**: Ensure that you choose a location with enough disk space. See System requirements. To see how much disk space is available on the machine, click **Space**.
   
10. Click **Next**.
    
   The Ready to Install the Program screen appears.
   
11. To review or change any of your installation settings, click **Back**. To continue the installation with the settings you have, click **Install**.
   
   A progress bar appears while Klocwork installs.
   
   The Setup Wizard Completed screen appears.
   
12. Click **Finish**.

### Running an unattended installation on Windows

To run an unattended Windows installation of the Distributed Analysis package, enter the following command:

```
<kw-dist-build-installer> /S/v"/qn [ADDLOCAL=<component_code>] INSTALLDIR=<install_directory> /lv* <log_file>"
```

**where:**

- `<kw-dist-build-installer>` is the name of the Windows Distributed Analysis installation executable
- `ADDLOCAL=<component_code>` is optional and allows you to install only the Server or the Agent component of the package
- `<component_code>` is either `DistributedAnalysisServer` or `DistributedAnalysisAgent`
- `<install_directory>` is the absolute path to the directory in which you want to install
Installing the Distributed Analysis package

- `/lv* <log_file>` allows you to log installation errors to file (recommended). The directory you specify must already exist. Use the absolute path to the log file.

**Note:** Surround any value that contains spaces with escaped quotation marks (`\`).

Example:

```
kw-dist-build-installer.9.5.0.0.windows.exe /S /v"/qn
INSTALLDIR="C:\Klocwork\9.5.0.0\Distributed Analysis"
<lvx* C:\Klocwork\dist_analysis.log"
```

**Log files for Windows installation**

An installation log file is saved to `%USERPROFILE%\Local Settings\Temp` whenever one of the Klocwork installation packages is started on Windows.

These log files are named `Klocwork<release-number>-<package>.log`. For example, the installation log file for the Klocwork 9.6 Server package is named `Klocwork9.6-Server.log`.

A logs directory is also created in the root Klocwork installation directory during installation on Windows. For the Server installer, for example, the log files in this directory store kwservice output when the servers are first started and the projects_root directory is initialized.

If you need to troubleshoot your installation, check these logs.

**What's next?**

Now it's time to Integrate Klocwork with your build.
Configuring and starting the Klocwork servers

Viewing and changing Klocwork server settings

Note: If the Klocwork Servers are running, you must stop them before attempting to change service properties. See Stopping the Klocwork Servers.

Viewing server settings
To view the host and port settings for the Klocwork Servers, use the command `kwservice get-service-properties` (this does not use a Klocwork license).

Setting the host name of the Klocwork Servers
If you have installed the Klocwork Servers in a central location and will be running one or more of the servers from another host machine, you will need to set the host name for these servers.

IMPORTANT NOTES:
• When issuing server configuration commands, the `projects_root` must be visible from the machine you're logged into.
• If you specify a different host for one or more Klocwork Servers using the procedure below, you will no longer be able to start the servers from the host where you previously started them.
• If the server hosts are located on a different subnet from the Klocwork clients, you must use the fully qualified host name for the Klocwork Servers in the procedure below. Otherwise, the clients will not be able to connect to the servers.
• You cannot change the physical host of the Klocwork License Server in the license file. If you need to move the License Server to another host, you must contact Klocwork for a new license file. However, you can use the procedure below if the name of the machine hosting the License Server has changed, or if you want to change how the host name is defined (for example, from a simple to a fully qualified host name). The host name in the license file must match the host name specified with the procedure below.
• If you have set up redundant License Servers, ensure that you specify the host name of the master License Server.
• See also Making network changes that affect the host name or IP address of a host machine.

To set the host name for one of the Klocwork Servers:
1. Stop the server, if is running. See Stopping the Klocwork Servers.
2. Run the following command:

```bash
kwservice --projects-root <projects_root> set-service-property <server_name> host <host_name>
```

where
• `<projects_root>` is the `projects_root` directory you want to use
• `<server_name>` is one of:
  • database
  • license
• klocwork
• <host_name> is the name of the machine that will host the specified server (Klocwork recommends using the fully qualified host name; see "Important Notes" above).

Example:

\[
\text{kwservice --projects-root C:\Klocwork\projects_root set-service-property database host server0196.acme.com}
\]

3. Start the server. See Starting the Klocwork Servers.

**Setting the ports used by the Klocwork Servers**

The following table shows the default port numbers for a new installation of the Klocwork Servers.

**Default port numbers**

<table>
<thead>
<tr>
<th>Server name</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Server</td>
<td>3306</td>
</tr>
<tr>
<td>License Server</td>
<td>27000 plus 33133</td>
</tr>
<tr>
<td>Klocwork Server</td>
<td>8080 plus 8081</td>
</tr>
</tbody>
</table>

**Important:**

• If you migrated from a previous version of Klocwork, your servers will be running on the ports stored in the old projects_root.
• Each Klocwork Server must run on a dedicated port. Do not set any other application to use the same port numbers.
• The Klocwork Server uses two consecutive ports (the one you choose, plus the next one).
• The default port for each server is the typical port for that type of server (for example, port 3306 is the typical port for a MySQL server), so if you will be running the Klocwork Servers on the default ports, ensure that you are not already running other servers on these ports.
• When setting a port number with the procedure below, the projects_root directory must be writable from the machine you’re logged into.
• When the Klocwork Servers are running behind a firewall, the firewall needs to be configured to allow client communication to the servers.
• If port 33133 is not available for use by the License Server, follow the instructions in Changing the vendor daemon port in your license file.

To set the port used by a Klocwork Server:

1. Stop the server, if is running. See Stopping the Klocwork Servers.
2. Run the following command:

\[
\text{kwservice --projects-root <projects_root> set-service-property <server_name> port <port_number>}
\]

*where*

• <projects_root> is the projects_root directory you want to use (mandatory argument)
• <server_name> is one of:
  • database
  • license
  • klocwork
• <port_number> is the port to be used by the specified Klocwork Server (defaults shown in table above).

3. Restart the server. See Starting the Klocwork Servers.
Example
To set the port used by the Klocwork Server to port 8074:

```
kwservice --projects-root C:\Klocwork_Server\projects_root set-service-property klocwork port 8074
```

Making network changes that affect the host name or IP address of a host machine

If you need to change any aspect of a server's network setup that will affect its IP address and/or its fully qualified host name, follow the procedure below to ensure that Klocwork applications continue to function properly.

**Note:** This includes the situation where you need to disconnect a Windows computer from the network, when you have installed both the servers and the clients on the computer.

To make a network change that will affect the host name or IP address of a machine hosting Klocwork Servers:

1. Stop the Klocwork Servers. See Stopping the Klocwork Servers.
2. Make your network configuration change (or disconnect your computer from the network).
3. If the Klocwork License server is running on the machine, make a backup copy of the Klocwork license file, then edit the license file to change the host name or IP address to the new host name or IP address.
4. Start the Klocwork Servers again. See Starting the Klocwork Servers.
5. Communicate the changes to anyone else who needs to know (for example, IT team, Klocwork administrator, build engineer, or development teams).

Starting the Klocwork Servers

The Klocwork Servers must be running before you perform project management tasks, and before Klocwork Insight can access data and reports.

**Note for Windows:** Depending on your configuration, you may be running the Klocwork Servers as Windows services, or as regular processes under the control of the kwservice utility. If you are running the Klocwork Servers as Windows services, you must use Windows Services administration to start, stop and check the Klocwork Servers, rather than kwservice or the Start Menu shortcuts.

Requirements for starting servers

- Either you must put a copy of your Klocwork license in the `<projects_root>/licenses` directory or
  
  If you will use your organization's FLEXlm license manager, you must configure a path to that server during installation, or with the kwservice set-service-property command. See Setting the host name of the Klocwork servers.
- You can manage the Klocwork Servers remotely on Unix with SSH, or on Windows with Windows Services administration. Otherwise, you must issue the start, restart and stop commands locally.
- The path to the `<projects_root>` must be the same on all server hosts.
- The path to the Klocwork executables must be the same on all server hosts.
- The user starting the Klocwork Servers must have write access to the `<projects_root>` directory.
Starting the Klocwork Servers

Starting the servers as regular processes

To start all of the Klocwork Servers as regular processes, run the following command:

```
kwservice --projects-root <projects_root> start
```

*where* `<projects_root>` is the projects_root directory you want to use

To start one of the Klocwork Servers, run the following command:

```
kwservice --projects-root <projects_root> start [server_name]
```

*where*
- `<server_name>` can be one of:
  - database
  - license
  - klocwork
- `<projects_root>` is the projects_root where the servers are running

**Tip:** On Windows, you can also start the Klocwork Servers by clicking **Start > All Programs > Klocwork 9.6 > Start Klocwork Servers.**

**Examples**

To start all Klocwork Servers:

```
kwservice --projects-root "C:\Klocwork\Server 9.6\projects_root" start
```

To start the Klocwork Server:

```
kwservice --projects-root "C:\Klocwork\Server 9.6\projects_root" start klocwork
```

You see messages indicating that the servers have been started, showing the server host name and port number and the path to the projects_root. For example:

- Using projects root: C:\Klocwork\projects_root
- Local Host is: serverxyz.com [13.1.1.142]
- Starting License Server [started on serverxyz.com:27000] (projects root is C:\Klocwork\Server 9.6\projects_root)
- Starting Database Server [started on serverxyz.com:3306] (projects root is C:\Klocwork\Server 9.6\projects_root)
- Starting Klocwork Server [started on serverxyz.com:8080]

Starting the servers as Windows services

Your Windows services may already be running. During installation you have the option of automatically starting the Klocwork Servers as Windows services when installation has completed.

**Note:** It is not possible to run two sets of the Klocwork Servers as Windows Services on one host when the servers are of the same Klocwork version. For more details, see Moving or creating additional projects root directories.

When running the Klocwork servers as Windows Services, the Klocwork Server is dependent on the Database Server. This means:

- When you start or restart the Klocwork Server, the Database Server will also start.
- When you stop the Database Server, the Klocwork Server will also stop.

To start or restart one or more Klocwork Servers as Windows services, use the Windows Services Administration Control Panel.
Alternatively, use the following commands:

```plaintext
net start "Klocwork 9.6 Database Server"
net start "Klocwork 9.6 License Server"
net start "Klocwork 9.6 Server"
```

**What's next?**

Now it's time to set up and analyze an integration project. See Integration build analysis.

---

**Stopping the Klocwork Servers**

**Warning:** If possible, schedule stopping the servers when users will not be using Klocwork applications, so that users do not lose data. Warn users that you plan to stop the servers.

Typically, once you have started the Klocwork servers, you leave them running indefinitely to handle information requests from Klocwork client applications. Occasionally, you may have to stop the servers when you are, for example, shutting down the machine running the server, upgrading your Klocwork software, replacing the license file, or changing your server configuration. Before you change server properties such as host name and port number, you must stop the Klocwork server whose properties you want to change.

**Note for Windows:** If you are running the Klocwork servers as Windows Services, which is the default setup, you must use Windows Services administration to start, stop and check the Klocwork servers, rather than kwservice or the Start Menu shortcuts.

**Requirements for stopping servers**

- You must be logged into the host machine directly. You cannot stop servers remotely.
- Prior to shutting down all Klocwork servers, advise users of Klocwork clients to shut down client applications. If they do not do so, they may lose data.

**Note:** The messages indicating that the servers have stopped actually occur while they are stopping. Before you start another process such as restarting the servers or doing a backup, wait a minute.

**Stopping the servers running as regular processes**

To stop all of the Klocwork servers running as regular processes, run the following command:

```plaintext
kwservice --projects-root <projects_root> stop
```

*where* `<projects_root>` is the projects_root directory you want to use

To stop one of the Klocwork servers, run the following command:

```plaintext
kwservice --projects-root <projects_root> stop <server_name>
```

*where*

- `<server_name>` can be one of:
  - database
  - license
  - klocwork
- `<projects_root>` is the projects_root where the servers are running
Tip: On Windows, you can also stop the Klocwork servers by clicking Start > All Programs > Klocwork > Stop Klocwork Servers.

Examples

To stop all Klocwork servers:

```
kwservice --projects-root "C:\Klocwork\Server 9.6\projects_root" stop
```

To stop just the Klocwork Server:

```
kwservice --projects-root "C:\Klocwork\Server 9.6\projects_root" stop klocwork
```

You see messages indicating that the servers have been stopped. For example:

```
Using projects root: C:\Klocwork\Server 9.6\projects_root
Local Host is: serverxyz.com [13.1.1.142]
Stopping License server [stopped]
Stopping Database server [stopped]
Stopping Klocwork server [stopped]
```

Tip: On Windows, you can also stop the servers from the Start Menu. Click Klocwork > Stop Klocwork Servers.

Stopping the servers running as Windows services

When running the Klocwork servers as Windows Services, the Klocwork Server is dependent on the Database Server. This means:

- When you start or restart the Klocwork Server, the Database Server will also start.
- When you stop the Database Server, the Klocwork Server will also stop.

To stop one or more Klocwork servers running as Windows services, use the Windows Services Administration Control Panel.

Alternatively, use the following commands:

```
net stop "Klocwork 9.6 Server"
net stop "Klocwork 9.6 Database Server"
net stop "Klocwork 9.6 License Server"
```
kwservice


You can manage the Klocwork servers remotely on Unix with SSH, or on Windows with Windows Services administration. Otherwise, you must issue the start, restart and stop commands locally.

For the remaining kwservice subcommands, the projects_root directory must be visible from the machine you're logged into.

Usage

kwservice [common-options] <subcommand> [options]

Example

kwservice --projects-root C:\Klocwork 9.6 Server\projects_root start license

Common options

<table>
<thead>
<tr>
<th>Name (and short name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--help</td>
<td>display this help</td>
</tr>
<tr>
<td>--projects-root (-r)</td>
<td>path to projects_root directory where the servers are running. Mandatory for all kwservice commands.</td>
</tr>
<tr>
<td>--verbose</td>
<td>print verbose information about program execution, which can help to troubleshoot errors</td>
</tr>
<tr>
<td>--version</td>
<td>print version information</td>
</tr>
</tbody>
</table>

Examples variables

The examples in this article use the following variables:

• <server_name> can be one of:
  • database
  • license
  • klocwork
• <projects_root> is the projects_root where the servers are running

kwservice check

Use the kwservice check command to check the status of all of the Klocwork Servers, or an individual Klocwork Server.

Note for Windows: If you are running the Klocwork Servers as Windows Services, which is the default setup, you must use Windows Services administration to start, stop and check the Klocwork Servers, rather than kwservice or the Start Menu shortcuts.

Usage

kwservice --projects-root <projects_root> check [<server_name>]

Examples

To check the status of all Klocwork Servers:
To check the status of the License Server:

```bash
kwservice --projects-root C:\Klocwork\projects_root check license
```

**kwservice get-service-properties**

Use the kwservice get-service-properties command to view the host name and port number of the Klocwork servers.

**Usage**

```bash
kwservice --projects-root <projects_root> get-service-properties <server_name>
```

**Examples**

```bash
kwservice --projects-root C:\Klocwork\projects_root get-service-properties klocwork
```

**kwservice list-services**

Use this command to list the Klocwork Servers.

**Usage**

```bash
kwservice --projects-root <projects_root> list-services
```

**Examples**

```bash
kwservice --projects-root C:\Klocwork\projects_root list-services
```

**kwservice restart**

Use this command to stop and then restart all or individual Klocwork Servers in one step.

**Note for Windows:** If you are running the Klocwork Servers as Windows Services, which is the default, you must use Windows Services administration to start, stop and check the Klocwork Servers, rather than kwservice or the Start Menu shortcuts.

**Note:** You can manage the Klocwork Servers remotely on Unix with SSH, or on Windows with Windows Services administration. Otherwise, you must issue the start, restart and stop commands servers locally.

**Usage**

```bash
kwservice --projects-root <projects_root> restart [<server_name>]
```

**Examples**

To restart all Klocwork Servers:

```bash
kwservice --projects-root C:\Klocwork\projects_root restart
```

To restart the License server:

```bash
kwservice --projects-root C:\Klocwork\projects_root restart license
```
**kwservice set-service-property**

Use this command to set properties for the Klocwork servers.

**Note:** You must stop the relevant server before running this command. See kwservice stop.

**Usage**

```
kwservice --projects-root <projects_root> set-service-property <server_name> <property> <value>
```

- `<property>` is one of the properties from the table below

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default value</th>
<th>Applies to these servers</th>
</tr>
</thead>
<tbody>
<tr>
<td>host</td>
<td>the host name of the specified server</td>
<td>localhost</td>
<td>all</td>
</tr>
</tbody>
</table>
| port     | the port number used by the specified server | License Server: 27000  
          |                                      | Database Server: 3306    
          |                                      | Klocwork Server: 8080     | all                      |

**kwservice setup**

Use this command to set up and initialize additional projects_root directories.

A single projects_root directory is created automatically during installation.

A projects_root directory is the data location for the Klocwork servers and applications. It contains Klocwork server settings and information about integration projects and build analysis runs. It also stores the Klocwork license file. The default location is `<Server_install>/projects_root`.

If you need to create additional projects_root directories, contact Klocwork Customer Support [4] for more information.

**Usage**

```
kwservice --projects-root <new_projects_root> setup [options]
```

**where:**

- `<new_projects_root>` is the path to the projects_root you want to create. Note that the parent directory of this directory must already exist.

**Important:** The maximum length of the path to the projects_root is 68-72 characters, depending on the length of the Database server (mysql) port number (1-5 digits).

**Examples**

```
kwservice --projects-root C:\Klocwork\projects_root_2 setup
```

**Options**
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--license &lt;arg&gt;</td>
<td>specify the license file. Use this option to copy the specified license file to the new projects_root directory.</td>
</tr>
<tr>
<td>--old-pr &lt;arg&gt;</td>
<td>specify an existing projects_root directory. Use this option to copy server settings from an existing projects_root.</td>
</tr>
</tbody>
</table>

**kwservice start**

Use this command to start all or individual Klocwork Servers.

**Note for Windows:** If you are running the Klocwork Servers as Windows Services, which is the default setup, you must use Windows Services administration to start, stop and check the Klocwork Servers, rather than kwservice or the Start Menu shortcuts.

**Note:** You can manage the Klocwork Servers remotely on Unix with SSH, or on Windows with Windows Services administration. Otherwise, you must issue the start, restart and stop commands on the servers locally.

**Usage**

```
kwservice --projects-root <projects_root> start [<server_name>]
```

**Examples**

To start all Klocwork Servers:

```
kwservice --projects-root C:\Klocwork\projects_root start
```

To start the Klocwork Server:

```
kwservice --projects-root C:\Klocwork\projects_root start klocwork
```

**Note on migrate option**

The `--migrate` option is used to migrate a projects_root from a previous version of Klocwork Insight. For information on upgrading, see Upgrading from a previous version.

**kwservice stop**

Use this command to stop all or individual Klocwork Servers.

**Note for Windows:** If you are running the Klocwork Servers as Windows Services, which is the default setup, you must use Windows Services administration to start, stop and check the Klocwork Servers, rather than kwservice or the Start Menu shortcuts.

**Note:** You can manage the Klocwork Servers remotely on Unix with SSH, or on Windows with Windows Services administration. Otherwise, you must issue the start, restart and stop commands on the servers locally.

**Usage**

```
kwservice --projects-root <projects_root> stop [<server_name>]
```

**Examples**

To stop all Klocwork Servers:

```
kwservice --projects-root C:\Klocwork\projects_root stop
```

To stop the Klocwork Server:

```
kwservice --projects-root C:\Klocwork\projects_root stop klocwork
```
Testing your installation

To test your Klocwork installation, you can either use one of the Klocwork sample projects, or create and analyze your own sample project.

Use one of the Klocwork sample projects

In `<Klocwork_install>\samples`, there are two directories:

- csvtosql (a sample Java project)
- Demosthenes (a sample C/C++ project)

Each directory contains a sample project and a readme file that shows you how to set up some sample analyses you can use to explore or demonstrate Klocwork.

**Note:** To successfully build a sample project on Unix you should have GNU make, GCC and bash.

Create and analyze a sample project

To test your Server package installation, you can create and analyze a sample project and then view the results of your analysis in Klocwork Review:

- C/C++ integration build analysis - Cheat sheet
- Java integration build analysis - Cheat sheet
- C# integration build analysis - Cheat sheet
What to communicate to the team

Your team of developers, managers, build engineer(s) and administrator(s) need to know the following:

- the location of the installation packages (if developers will install their own Klocwork tools)
- the URL of the Klocwork Server, so that managers and developers can access Klocwork Review and Klocwork Inspect
- that the URL of the Klocwork Server with "/documentation" added to it will give them all of the Klocwork online documentation
- the location of the projects_root directory (Klocwork administrators only)
- the host and port of the License Server
- who has permission to start and stop the Klocwork Servers, under what user ID, and, for Windows, whether the servers must be managed as Windows Services

If anyone else needs to access the database (either the Klocwork Database Server or a separate MySQL database), for example, to do backups, and you have locked the database with a password, give the person the password. See Setting a password for the Klocwork database for more information.
Troubleshooting

Repairing a Windows installation of Klocwork Insight

If files in the Klocwork installation were accidentally damaged or deleted, you can repair the installation.

You may discover that your Klocwork installation is damaged, for example, if you are attempting to uninstall Klocwork and see the error message "Fatal error: Cannot uninstall".

If this occurs, click OK in the error message dialog to cancel the uninstallation, perform the following repair procedure, and then run the uninstallation procedure again.

To repair a Klocwork installation on Windows:

1. In the Start menu, click Control Panel > Add or Remove Programs.
   The Add or Remove Programs dialog appears.
2. Select the Klocwork package you want to repair, and select Click here for support information.
   The Support Info dialog for the selected Klocwork package appears.
3. Click Repair.
   The installation is restored to a clean state.

See also:

• Uninstalling Klocwork Insight
• Installing Klocwork Insight
• Troubleshooting
Package Load Failure occurs in Visual Studio after I install patch

You can either:

• uninstall the patch and install the last full version of the Klocwork User installer, or
• from the `<user_install>\inforceVSNET` directory, run the following command:

```
regsvr32 IfPkgVS2005.dll
```

Error reading setup initialization file during installation

If you see the following error during installation on Windows:

```
Error reading setup initialization file
```

Ensure that your Windows system drive (normally the C: drive) has free space. The Windows installer requires space on the system drive, even if you install Klocwork on a different drive.

Klocwork support for non-ASCII encoding

Klocwork Insight 8.1 or later is fully internationalized, meaning that it accepts multibyte characters, such as Japanese, in:

• source-file contents (note that for C/C++, multibyte characters are allowed only in comments and strings)
• source-file names and paths (see Limitations related to internationalization)
• tables directory paths
• comments on detected issues
• custom checker help files (Note that multibyte characters are not permitted in issue codes)
• configuration files
• user authentication management (for example, LDAP access control)
• Checker Studio

Characters which are used in file system paths must be representable in your current encoding. For example, if Japanese characters are used in paths to source files or to the tables directory, then the current encoding should be appropriately set to support Japanese characters. On Windows, this means that the language for non-unicode programs must be set to Japanese. To change this property, go to Control Panel > Regional and Language options > Advanced, select Japanese, and restart your computer.

See also:

• Limitations related to internationalization
• kwconv
Unable to start Klocwork Servers following Windows installation

If you see one of the following messages after installing the Klocwork Server package on Windows:

- Error 1920. Service Klocwork 9.6 Server (Klocwork 9.6 Server) failed to start. Verify that you have sufficient privileges to start system services.
- Service Klocwork 9.6 License Server failed to start. See installation log for more details.

An earlier version of the Klocwork Server and/or Klocwork License Server may be running on the port that you specified during installation of Insight 9.6. It is not possible to run two versions of a server on the same port.

You need to set a different port number for the 9.6 Klocwork Server and/or 9.6 Klocwork License Server with `kwservice set-service-property`, and then start the servers.

See also
- Installing Klocwork Insight

IntelliJ IDEA installation not detected; plugin not installed

The IDEA plug-in may not be detected if:

- (on Windows) if you installed IntelliJ IDEA 8.x by unzipping files, rather than with the MSI installer, the Klocwork Insight 9.x User package installer will not be able to detect your IntelliJ IDEA installation, and the plug-in will not be installed.
- (on Linux) you didn't specify the directory where IntelliJ IDEA is installed on your machine with the `--idea-dir` installation option.

Windows

You will need to force the IntelliJ IDEA plug-in installation from the command line:

```
<installer.exe> /v"IDEA=1 IDEAINSTALLDIR=<idea_install>"
```

where

- `<idea_install>` is the directory where IntelliJ IDEA is installed; surround the path in quotation marks if it contains spaces

For example:

```
kw-user-installer.9.6.0.0.windows.exe /v"IDEA=1 IDEAINSTALLDIR="C:\IntelliJ IDEA\"
```

For more details on running the Windows command-line installer, see Unattended installation on Windows.
**Linux**

1. **Delete** the `<user_install>` directory. This will uninstall the user package.
2. **Re-install** the user package, specifying the `--idea-dir` option:

```bash
<installer.sh> --idea-dir <idea_install> <user_install> [KJ_IDEA]
```

**where**

- `<idea_install>` specifies where IntelliJ IDEA is installed on your machine; surround the path in quotation marks if it contains spaces
- `<user_install>` is the location where you want to install Klocwork; surround the path in quotation marks if it contains spaces
- `KJ_IDEA` indicates that only the IDEA plug-in is to be installed (optional)

For example:

```bash
kw-user-installer-9.6.1.1.linux.sh -a --idea-dir "/home/jlee/JetBrains/IntelliJ IDEA 9.0" "/opt/klocwork/user 9.6" KJ_IDEA
```

For more details on installing the user package, see Installing the Klocwork User package on Unix.
Uninstalling

Uninstalling Klocwork Insight

Before you uninstall

If you will be modifying or uninstalling a Server package or connected desktop installation, you must stop the Klocwork Servers first. See Stopping the Klocwork Servers.

If you are uninstalling the Server package, in addition to stopping the servers, you should also make a backup copy of your projects_root directory and any configuration files you modified, such as kwfilter.conf. For Unix and Windows, compiler configuration files are located in <server_install>/config; for Mac they are located at /Library/Frameworks/KlocworkServer.framework/<version>/config. For more information about backing up data, see Backing up Klocwork data.

While the Windows version of the Klocwork Server package won't uninstall the projects_root directory or configuration files, it's a good idea to make a backup of these directories to be on the safe side, particularly if you're uninstalling a version previous to 7.7. For Unix systems, there is no automated uninstall, so make sure you back up your projects_root and any other data files you want to keep and store them outside your Server installation directory. Then you can delete the Server installation directory.

See also Repairing a Windows installation of Klocwork Insight.

Uninstalling on Windows

Note: Uninstalling the User package uninstalls the plug-in from Visual Studio and IntelliJ IDEA. You must uninstall the update site to remove the plug-in from Eclipse.

Viewing installed components or modifying your installation on Windows

Use the procedure below if you want to remove one or more Klocwork components from either the Server or User package, or if you need to check what components are currently installed. For example, if you need to uninstall Klocwork before installing a new version, you should check what components are currently installed before uninstalling, so that you can install the same components for the new version.

To view installed components or partially uninstall Klocwork:

1. In the Start menu, go to Control Panel > Add or Remove Programs.
   
   Windows 7: From the Control Panel window, under Programs, select Uninstall a program.

2. Scroll to and click the Server or User package you want information on.

3. To find information about patches, make sure the Show updates checkbox is selected at the top of the Add or Remove Programs panel.
   
   Windows 7: Click View installed updates in the upper right.

   The installed patches will be displayed under the Klocwork installation package entry.

4. Click Change.
   
   Windows 7: Right-click the Klocwork installation package and select Change.

   The Welcome screen for the Modification wizard appears.
5. Click Next.
   The Program Maintenance panel appears.
6. Select Modify and click Next.
7. The Custom Setup screen appears. Click through it to see what components (features) are installed.
   **Note:** This symbol indicates a component that is installed: 
8. If you are simply viewing installed components:
9. Record which components are installed.
10. Click Cancel.
11. Click Yes when asked if you are sure.
12. Click Finish.
13. If you want to uninstall certain components, or install components you did not previously install:
   14. For the components you want to uninstall, click This feature will not be available.
   For the components you want to install, click This feature, and all subfeatures, will be installed on local hard drive.
15. Click Next.
   The Ready to Modify the Program screen appears.
16. Click Install.
   The features you selected will be modified.
17. Click Finish.

**Uninstalling Klocwork from a Windows machine**

**Note:** You can also uninstall Klocwork with the Windows Add or Remove Programs Control Panel, but you will not get logging information.

To remove a Klocwork software package:

1. Run the following command:

   `<installer.exe> /X`

   *where* `<installer.exe>` is the package you want to uninstall

2. The Choose Setup Language screen appears.
   Select the appropriate language and click OK.
3. When prompted, click Yes to uninstall the product.
   An uninstallation log file will be saved to `%USERPROFILE%\Local Settings\Temp. The log file is named Klocwork<release-number>-<package>.log. For example, the uninstallation log file for the Klocwork 9.6 Server package is named Klocwork9.6-Server.log.

**Uninstalling in unattended mode on Windows**

To run uninstallation in unattended mode from a Windows machine, enter the following command:

`<installer.exe> /S /v"/qn REMOVE=ALL"`

*where* `<installer.exe>` is the package you want to uninstall

An uninstallation log file will be saved to `%USERPROFILE%\Local Settings\Temp. The log file is named Klocwork<release-number>-<package>.log. For example, the uninstallation log file for the Klocwork 9.6 Server package is named Klocwork9.6-Server.log.
Uninstalling on Unix

Viewing installed components on a Unix machine

If you are upgrading to a new version of Klocwork, check what components are currently installed before uninstalling, so that you can install the same components from the new version.

To list installed components (features), run the following command:

```bash
kwupdate [option ...] --list
```

See `kwupdate` for the full list of options.

Uninstalling from a Unix machine

**Note:** Uninstalling the User package uninstalls the plug-in from IntelliJ IDEA. You must uninstall the update site to remove the plug-in from Eclipse.

To uninstall on Unix, simply delete the Server package and/or User package installation directory.

Uninstalling on Mac

**Note:** Uninstalling the User package uninstalls the plug-in from IntelliJ IDEA. You must uninstall the update site to remove the plug-in from Eclipse.

To uninstall, delete the following directories:

- `/Applications/Klocwork Server 9.6`
- `/Applications/Klocwork User 9.6`
- `/Library/Frameworks/Klocwork*.framework`
- `/usr/local/kw`

Uninstalling the plug-in from Eclipse and IntelliJ IDEA

For **Eclipse**, uninstalling the User package does not uninstall the plug-in; to uninstall the plug-in, follow the steps in this section.

For **IntelliJ IDEA**, you have two choices: you can uninstall the User package as detailed above, or uninstall just the plug-in by following the steps in this section.

Eclipse

To uninstall the Klocwork plug-in from Eclipse:

<table>
<thead>
<tr>
<th>Eclipse 3.4</th>
<th>Eclipse 3.5 and 3.6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. From the Help menu, choose Help &gt; Software Updates &gt; Manage Configuration.</td>
<td>1. From the Help menu, choose Help &gt; About Eclipse”</td>
</tr>
<tr>
<td>2. The Product Configuration dialog appears.</td>
<td>2. Click Installation Details.</td>
</tr>
<tr>
<td>3. Expand the items in the navigation pane until you see the Klocwork feature.</td>
<td>3. Select the Klocwork plug-in from the list and click Uninstall.</td>
</tr>
<tr>
<td>4. Right-click the Klocwork feature and choose Uninstall, and click Yes to confirm that you want to disable this feature.</td>
<td></td>
</tr>
</tbody>
</table>

When you’re prompted to restart Eclipse, click Yes.

Once Eclipse restarts, the Klocwork buttons and menu items are no longer present. If you haven’t uninstalled the Klocwork User package as described above, your Klocwork projects remain in their storage location.
**IntelliJ IDEA**

1. Go to File > Settings.
2. Under IDE Settings, click Plugins.
3. Right-click Klocwork for Java in IntelliJ IDEA and select Uninstall.
4. Close IntelliJ IDEA.
5. Restart IntelliJ IDEA to confirm the removal by ensuring that the Klocwork button has been removed.

**Note:** You must restart IntelliJ IDEA after uninstallation, before you install a new version of Insight.

---

**Unable to start Klocwork Servers following Windows installation**

If you see one of the following messages after installing the Klocwork Server package on Windows:

- Error 1920. Service Klocwork 9.6 Server (Klocwork 9.6 Server) failed to start. Verify that you have sufficient privileges to start system services.
- Service Klocwork 9.6 License Server failed to start. See installation log for more details.

An earlier version of the Klocwork Server and/or Klocwork License Server may be running on the port that you specified during installation of Insight 9.6. It is not possible to run two versions of a server on the same port.

You need to set a different port number for the 9.6 Klocwork Server and/or 9.6 Klocwork License Server with kwservice set-service-property, and then start the servers.

**See also**

- Installing Klocwork Insight
Article Sources and Contributors


Image Sources, Licenses and Contributors

